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Course Description
This two-day course is the starting point for those responsible for performing Dialogue system
administration activities. 

It provides an introduction to and hands-on experience with installation, setup, and maintenance
of the Dialogue environments and objects needed to standardize the creation and production of
customized communications.

This course is designed as an introduction to maintaining Dialogue. To perform advanced 
administrative functions, you need to complete higher levels of training.

Course Goals
To provide Dialogue system administration, you must be able to:

• Install and upgrade Dialogue.

• Set up the System Environment.

• Set up the Design Environment.

• Set up the Delivery Environment.

• Maintain the Dialogue Environment.

This course is designed as an introduction to system administration. To perform higher-level 
output and delivery tasks, you need to complete higher levels of training such as 211 :: High-
Volume Delivery or reference the System Administration Guides.

Audience
Individuals responsible for performing Dialogue’s system administration activities.

Prerequisites
Prior to taking this course, you must have successfully completed:

• 101 :: Introduction to Dialogue



Course Design Course Design
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Course Units

– Scenario

– Lessons

– Exercises

Course Materials

– Symbols

– Page Layouts

Course Design
The course consists of five units and a self-assessment, designed to build your skills and
knowledge from unit to unit. This course presents job relevant system administrator tasks,
designed around the day in the life of a system administrator. Throughout the course you’ll be
referencing this Student Guide and an accompanying Project Guide.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Course Design
This course is designed using a lecture-lab format. During the lecture portion, the instructor sets
the stage by presenting a scenario that provides a series of requirements. After setting the stage,
you learn how to use Dialogue to meet those requirements by:

• Listening to the instructor.

• Viewing a series of slides and your guide.

• Observing instructor-led demonstrations.

• Discussing and reviewing content.

• Completing and reviewing hands on exercises.

Units
The complexity of the assigned communications, as well the skills and knowledge learned and
applied, increase from unit to unit.

Unit flow

The course contains a series of units. The first unit contains introductory information about the
course. The remaining course units are instructional units, as they correspond to each course goal.
Units contain a series of lessons, exercises, and a summary.
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Course Units
Course units include several instructional strategies.

Course units organization 

Scenario
Each unit starts with a scenario that describes a personalized communication that you are then
asked to create. It includes the requirements and information necessary to create the
communication. When reviewing the scenario, you are asked to start the Planning and Analysis
phase of the Life Cycle process by identifying the requirements and information needed to
complete the communication.

Lessons
Each lesson includes:

• A scenario presenting a series of job-relevant requirements.

• Objectives to identify the skills you will be able to perform at the end of the lesson.

• Skills and knowledge as they relate to the objective.

• Demonstrations of how to use Dialogue.

• Exercises to allow you to apply the skills and knowledge presented in each lesson.

Exercises
Throughout the course, exercises are provided for instructional purposes. Depending on your
learning style, you can complete the exercises in one of two ways:

• Independent Exercises - Provide high-level processes to complete the assigned tasks in
Dialogue.

• Guided Exercises - Provide step-by-step procedures to complete the assigned tasks in
Dialogue.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Course Materials

Guides
You use the following materials in this course:

Symbols 
The following symbols are used in the course Guides:

Text Conventions
The following text formatting conventions are used in the course guides:

• Example - Text  you find on the interface.

• Example - Name of a guide to reference for more information.

• Example - Text being defined.

• Example - Text you enter into a field on the interface.

• Example - An important word for you to remember.

Guides Contents

Student Guide • Introductions

• Conceptual information

• Appendix

• Self-assessment

• Summaries

• Reference information

• Independent exercises

• Guided exercises

Project Guide • Scenario content

Dialogue Interface 
and Shortcut Quick 
Reference Guide

• Design Manager interface

• Design Manager shortcuts

• Designer interface

• Designer shortcuts

Symbol Indicates Symbol Indicates

Useful tips Exercise
Start of exercise

Warning Success!
End of exercise

Demonstration :: Note Additional information

Go to Project Guide
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Page Layouts
The Dialogue System Administration Student Guide uses the following page layouts.

Sample lesson page

Unit title

Lesson title

Unit number

Page number

Guide version

Guide title

Tip

Definition

Warning
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Sample Independent Exercise page

Start of exercises

End of exercise
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Sample Guided Exercise page

Start of Guided Exercises

Exercise title

Start of exercise

End of exercise
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Course Schedule Schedule

– Day 1

– Day 2

Course Schedule
Your instructor keeps the course moving at a reasonable pace. The instructor may need to make
some adjustments to the schedule based on your training needs.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Schedule
Please stay with the course, even if you feel you are already familiar with the material and
concepts. 

The course uses the following schedule. 

Day 1

Day 2

Activity

Welcome and Introduction

Unit 1: About This Course

Unit 2: Installation and Initial Settings

Unit 3: Setting up the System Environment

Unit 4: Setting up the Design Environment, (Part I)

Activity

Unit 4: Setting up the Design Environment, (Part II)

Unit 5: Setting up the Delivery Environment

Course Self-Assessment
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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ScenarioScenario

– About Vivanet

– Your Responsibilities
The tasks you complete in this course are presented as part of the following scenario.
gue version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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About Vivanet
Vivanet Communications is a market leader in providing local, long distance, wireless, Internet
access, and data services to business and residential customers across Kentucky.

Recently, Vivanet installed Dialogue on several Information Technology, Sales, and Marketing
workstations, including your own. Previously, each department created and managed
communications using several different systems that no longer meet corporate needs.

Your Responsibilities
You must set up Dialogue to provide demonstrations of functionality in the areas of the user, 
design, and delivery environments. You are working with John Blake, the sales associate who 
purchased Dialogue for Vivanet, in arranging the demonstrations. As the head of the IT 
department, your responsibilities include:

• Installing Dialogue.

• Upgrading Dialogue.

• Maintaining the Dialogue database.

• Maintaining the Dialogue environments.

• Adding new objects to the Dialogue Environment.
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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Dialogue Installation Dialogue System Requirements

Dialogue Installation Process

Software Download

– Release Versions

Installing the Software and 
Documentation

– Installing the Software

– Installing the Documentation

How Dialogue Uses Databases

– Supported Databases

– Default Databases

Creating a New Access Database

Creating a System DSN

Updating the Database

Running Database Maintenance

Login Methods

Independent Exercises

Guided Exercises

– Copy and Rename the Database

– Create a System DSN

– Update the Database

Dialogue Installation
Installing Dialogue is a simple process of downloading the software then setting up the database.
As Dialogue relies on external databases to contain all data about the objects and users, the
database is of utmost importance. 

This lesson provides the process for installing Dialogue.

Objectives
By the completion of this lesson, you will be able to:

• Identify the Dialogue system requirements.

• Identify the steps of the Dialogue installation process.

• Identify how to download the software.

• Identify how to install the software and the documentation.

• Identify how Dialogue uses databases.

• Create a new Access database.

• Set up a DSN for an Access database.

• Update the database.

• Identify Database Maintenance.

• Identify login Methods.

Terms
New terms used in this lesson include:

• DSN (Data Source Name) - A database representation that enables Dialogue to connect to the
design database.

• Schema - A group of related tables in relational databases. Schemas separate the various tables
in a database into more manageable groupings.

Additional Information
For more information on this topic, refer to the Dialogue:

• Getting Started Guide.

• System Administration Guide.

.

For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Dialogue System Requirements
To install and run the full installation of Dialogue for the design environment, you need:

• A Pentium III Windows workstation with:

– 400 mHz or greater processor speed.

– 256 megabytes of RAM.

– At least 100MB of free disk space.

• A valid system key (EKF) to enable Dialogue and run the Engine.

• The zip file password for the version you have downloaded.
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Dialogue Installation Process
Installing Dialogue is a simple process, involving downloading the software, running the
installation, and preparing the database for use.

Complete the following steps to prepare Dialogue for the initial login:

1. Obtain a user name and password from your Exstream Account manager.

2. Download the software and documentation from Exstream’s site.

3. Install the software and documentation.

4. Create a system DSN (if needed).

5. Update the database.

This lesson guides you through each of these steps.
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 Tip

There is no installation CD for 
Dialogue.

 Tip

If your organization has purchased
the DBCS version of Dialogue, the
License Information tab displays
that information.
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Software Download
 All Dialogue products are downloaded from the Exstream web site. You must obtain a login and 
password to access the Dialogue download site. You also need a password to open the 
downloaded files. Once you have obtained this information, download the software and products 
available to you.

To download, go to http://www.exstream.com, log in, and download the version you want to a
temporary directory on a local drive. The file is compressed -- unzip the file into the temporary
directory.

The Exstream website

Release Versions
Dialogue is released in two methods:

Generally, a GA is a combination of several MRs. MRs are a response to a specific request by an
Exstream customer. You can also download updates to the software from the website, under the
Upgrade folder.

Character Sets
Each release version is available with the following character sets:

To determine which character sets are available to you in Dialogue, browse to the License tab in
the System Settings.

:: Note

Your Exstream Account Manager provides you with the necessary passwords.

Version Type Description

General availability (GA) Official, announced versions of Dialogue.

Managed release (MR) Versions with small changes or new features.

Character Set Description

SBCS (Single Byte Character
Set)

• Represents 256 different characters at any time.

• Supports Native, ASCII, and EBCDIC using code pages.

DBCS (Double Byte Character
Set

• Represents all characters internally using Unicode.

• Supports double-byte character sets such as Traditional
Chinese and EUC-JN (Japanese).
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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 Tip

Dialogue supports a unique 
registry entry for each instance of 
Dialogue installed. This enables 
you to react more quickly to 
software changes, as well as test 
applications without affecting 
production. 
Installing the Software and 
Documentation
Now that the software has been downloaded, you must install it onto your system.

Installing Dialogue
To begin the installation, run the installer. A wizard then takes you through the installation process.
The wizard specifies default installation folders and other configuration settings. If you already
have the default Data Source Names (DSNs), a DOS window opens and prompts you to overwrite
them. A warning dialog box opens if you have previously installed Dialogue. Do not click Replace
unless you want to overwrite the default database and potentially lose all information.

Documents Included with the Software
The following documents are installed with the software, in the application directory.

Readme.txt
The Readme.txt file is placed in the Exstream program directory during the installation process.
It provides important information about your Dialogue system, such as:

• Startup and installation information.

• The system administrator login and password.

• Other user logins and passwords.

• Uninstallation information.

Release Notes
Each general availability and managed release of Dialogue is accompanied by the Dialogue
Release Notes. Release Notes also explain the major difference between versions of Dialogue.
The Release notes do not completely document all the features of a major release. Instead,
release notes:

• Contain high-level information.

• Explain the benefit of the function or feature.

• Provide a brief technical explanation of the function or feature.

• Indicate new features and changes in the documentation.

• Provide information about changes in product support. 

Maintenance Release Notes
If you have a question that is related to the software version, check the maintenance release notes.
Maintenance release notes contain information about interim improvements made to the software
between releases.

Installing the Exstream Documentation Set
The Exstream documentation set consists of a series of books in PDF format. They are
downloaded individually or all together in the Reference Guides.zip file. This zip file contains
an executable which places the guides in your Exstream program directory.

:: Note

Updating the software uses the same procedure as the installation.
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Save guides to your C:\Program Files\Exstream\Exstream Dialogue Guides <Version>
directory. This enables Dialogue’s context-sensitive help to access the relevant guide.

Documentation and Training Catalog
The documentation suite also includes a training catalog, which provides:

• A list of the guides and the descriptions.

• A list of courses and their descriptions.

:: Note

If the guides are not installed in the proper directory, the context-sensitive help will not 
function properly.
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 Tip

Keeping backups of all Dialogue-
related databases and files for your 
system is highly recommended.

Schemas are a group of related 
tables in relational databases. 
Schemas separate the various 
tables in a database into more 
manageable groupings.
How Dialogue Uses Databases
Now that the software has been installed, take a moment to make sure the database is ready. As a
database-centric application, the database is of utmost importance.

Dialogue uses databases for three purposes:

• Design database - Contains information about objects and system settings.

• Data source - Populates data files and variables in Dialogue.

• Tracking - Collects data and other information about marketing campaigns.

Supported Databases
Dialogue installs a Microsoft Access database for your initial use, but your installation of Dialogue
can use Oracle, SQL Server, or DB2 databases instead. The related installation scripts are included
with each particular platform as purchased.

Dialogue supports the following database platforms.

• Access (97 and above)

• Oracle (8.i and above)

• SQL Server (7)

• DB2 (7.2.0)

For multi-user environments, use Oracle, SQL Server, or DB2 databases with multiple database
schemas. A pre-defined Access database is used for this class.

Default Databases
The Dialogue installation procedure creates three Microsoft Access databases for initial use. They
are normally installed on the design workstation in the default directory C:\Program
Files\Exstream\

:: Note

Microsoft Access databases do not support schemas.

Database Name Description

Exstream.mdb • Contains sample objects.

• Created for test use.

EmptyExstream.mdb • Does not contain any objects.

• Used with the UpdateDB utility to send test cases.

Tracker.mdb • Contains the Customer Knowledgebase, featuring
information about campaigns.

• Used only with the Advanced Campaign Management
module.
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Creating a New Access Database
To create a new Access database, browse to the C:\Program Files\Exstream\ directory, right-
click the EmptyExstream.mdb database, and select Copy. 

Copy the database

Browse to the location of the new folder, right-click in the directory, and select Paste.

Paste the copy

Then right-click the copy and select Rename. Rename the database.
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A DSN (Data Source Name) is a 
database representation that 
enables Dialogue to connect to the 
design database.
Creating a System DSN
When you use a database other than the default Exstream design database, you create a system
DSN (data source name) to direct the system to the database. The default database does not
need a DSN: Dialogue provides one for it. A DSN is a shortcut, so you do not have to browse to
find the database.

The DSN includes the:

• Database name.

• File path to the database.

• ODBC driver type.

• Username and password used to access the database.

Creating a new DSN

Once a DSN has been created for a specific database, it is used in an application to access the
database. Dialogue provides Microsoft Access databases for the local test environment, but use
Oracle, SQL Server, or DB2 in multi-user environments.

When creating DSNs for use by Dialogue, you must ensure that you are creating a system DSN.
This enables all users to access the specified design database.
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Make a backup of your database 
before you update it.
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Updating the Database
You need to update the database before logging in for the first time. Updating is done with an
external file called UpdateDB.exe in the Exstream directory. This application updates the
indicated database to the version of Dialogue that was installed on the workstation.

The Update Database Administrator

For more information about the Interface Panel, please see the Dialogue Administrator
Guide.

Feature Explanation

Database Information Details the database information, such as name, schema, and
version.

Interface Panel Enables you to set update values and copy the database. 

Version Control Enables you to specify the database version.

Log File Indicates the log file that records all database activity.

Query File Indicates the log file that records all database queries.

SQL Scripter Generates the update sequence as an SQL script (does not
update until the script runs).

Update Database Button Activates the database update.

Database 
information

Version Control

Log file

Query File

SQL Scripter

Update Database 
Button
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Invalid Database
If the database does not work, or error messages are occurring, check for the following issues:

• The database may be in use - Make sure that there are no running instances of Dialogue.

• The database may have the incorrect Dialogue version - Update the database.

• The database may be corrupted - Try using a backup or copy.

• The indicated database may not be supported.

• The database may be set to Read-Only.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
 Tip

The database may be in use error 
occurs only with Access, which 
does not support multi-user 
access.
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Running Database Maintenance
Dialogue contains a Database Maintenance Tool, which checks your database for any errors that
are slowing down operation and interfering with proper referencing. You access the Database
Maintenance Tool at Tools -> Database Maintenance from the Design Manager.

Database Maintenance Application

:: Note

You cannot run the database maintenance until you log into Dialogue.
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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The database maintenance application checks for the following issues:

When the maintenance application finishes scanning for errors, it presents a report. Select Fix
Errors to address the issues found.

For more information about the Database Maintenance Application, please see the Dialogue
Administrator Guide.

Setting Function

Check Serialized LOB 
Integrity

This checks and fixes rules and variables in components.

Check for Orphaned Rules This finds unnamed rules that are not used by any objects and 
deletes them.

Check database 
referential integrity

This checks the many references between tables, including 
relationships that are not enforced though database referential 
integrity.

Create log file only when 
database updated 

If selected, a log file is only generated when you fix problems in 
the database. If cleared, a log file is always produced.

Verbose status display This controls how much information is displayed in the on-
screen display.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Login Methods
When loading, Dialogue prompts you for the design database. Select the design database you
wish to use for the upcoming session. You also control how users log into Dialogue by specifying

the following options in the Database and Password Options area on the Select Database tab.

Method Details

Default user and password • The User Logon dialog box captures and displays your
Windows user ID from the network. 

• A password is not needed.

– If you use a different user ID in the User field, you 
must type a password.

NT authentication • This is used for databases configured to use the security
built into their Windows NT network.

• Dialogue connects to the database without specifying a
user ID or password. A login is not necessary with this
method.

Prompt for user and password • You are prompted to enter two sets of user IDs and
passwords.

– The database user ID and password.

– The Dialogue user ID and password.

Database and Dialogue • You are prompted to enter a user ID and password used
to log in to both the database and Dialogue.

  Demonstration Observe the demonstration.
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Independent Exercises: Dialogue 
Installation

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Create a Vivanet database and create a DSN for the Vivanet database.

Task Specifics

Copy and Rename the database • Copy the EmptyExstream.mdb database.

• Place it in the C:\110 Dialogue System 
Administration\ directory.

• Rename it Vivanet.

Set up a system DSN • Use a Microsoft Access ODBC driver.

• Name the system DSN Vivanet.

• Use the Vivanet.mdb Access database.

Update the database • Update the Vivanet.mdb database.

 Success! You have completed the Dialogue Installation exercise.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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 Tip

You open Windows Explorer by 
clicking Start -> Run, typing 
explorer in the Open text box, 
and clicking OK.
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Guided Exercises: Dialogue 
Installation

Copy and Rename the Database

In Windows:

The EmptyExstream.mdb file is renamed to Vivanet.mdb.

 Exercise Set up a new Vivanet design database in Microsoft Access. Copy the 
EmptyExstream.mdb to create the new database.

Step Action Display

1. Open Windows Explorer. Windows

2. Browse to C:\Program Files\Exstream. Windows Explorer

3.
Right-click the EmptyExstream.mdb file and 
select Copy from the shortcut menu.

4.
Browse to C:\110 Dialogue System 
Administration\.

5.
Right-click within the folder and select Paste 
from the shortcut menu.

The EmptyExstream.mdb file is copied in the Class Database folder.

6.
Right-click the EmptyExstream.mdb file and 
select Rename from the shortcut menu.

7. Type Vivanet.mdb and press ENTER.

 Success! You have created a new Access design database.
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Set Up a System DSN

IIn Windows NT/2000/XP:

The new system DSN is created.

 Your Turn Set up a system DSN to point to the Vivanet.mdb design database.

Step Action Display

1.
Go to Start -> Control Panel -> Administrative 
Tools -> Data Sources (ODBC).

Windows

The ODBC Data Source Administrator dialog box opens.

2. Check the System DSN tab.

3. Click the Add button. System DSN tab

The Create New Data Source dialog box opens.

4.
Select Microsoft Access Driver (*.mdb) from the 
list.

5. Click Finish.

The ODBC Microsoft Access Setup dialog box opens.

6.
Enter Vivanet in the Data Source Name text 
box.

7.
Enter New Vivanet Database in the 
Description text box.

8. Click the Select button.

The Select Database dialog box opens.

9.
Browse to the C:\110 Dialogue System 
Administration\Vivanet.mdb file

10. Click OK.

You are returned to the ODBC Microsoft Access Setup dialog box.

11.
Click OK.
You are returned to the ODBC Data Source 
Administrator dialog box.

12. Click OK.

 Success! You have set up a system DSN for the Vivanet.mdb design database.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Update the Database

In Design Manager:

 Exercise Update the Exstream Dialogue database.

Step Action Display

1.
Log all users out of Dialogue and close the 
application

Design Manager

2.
Browse to the C:\Program Files\Exstream 
folder.

Windows

3. Double-click UpdateDB.exe.

The Dialogue Database Administrator opens

4. Click Select database.

The Select DSN dialog box opens

5. Select Vivanet. Select DSN dialog box

6. Click OK.

7. Click the Update Database button

The Update completed successfully with no errors dialogue box opens

8. Click OK and Exit.

 Success! You have updated the Exstream database.
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Administrator

– User Login Dialog Box

Setting Up Keys and Licensing

– Dialogue Keys

– Obtaining a License

– Suites and Modules

Browse the Environment

– Environment Settings

Administering System Settings

– Basic

– Text and Fonts

– Workflow

– Campaign

– Production Print

– License

Setting System Configuration

Independent Exercises

Guided Exercises

– Locate the System Administrator 
Login and Password

– Log into Design Manager

– Customize the System Configuration

Initial Dialogue Settings
By default, certain system settings are configured as part of the installation or upgrade process.
Understanding how these initial Dialogue settings affect a new or upgraded installation is
important to setting up the system environment.

This lesson covers the remainder of the Dialogue installation: licensing and basic navigation.

Objectives
By the completion of this lesson, you will be able to:

• Access Dialogue as an Administrator.

• Set up Keys and Licensing.

• Browse the Environment.

• Administer System Settings.

• Set System Configuration.

Terms
New terms used in this lesson include:

• EKF - An Exstream Key File containing a 50-character code. This code determines what features
are available.

• IJPDS - An Ink Jet Printer Data Stream is a printer option that supports high-speed, full-color 
production with any number of print heads.

Additional Information
For more information on this topic, refer to the Dialogue: 

• System Administration Guide.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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 Tip

For the system administrator login 
and password, see the 
Readme.txt file included with 
your Dialogue installation.
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Accessing Dialogue as an 
Administrator
When accessing Dialogue for the first time, log in under the ADMIN user account. This user is
created by default with each new database and enables you access to Dialogue. You start
Dialogue:

• From the Windows Start menu. Start -> Programs -> Exstream Software -> Dialogue ->
Dialogue Design Manager

• By double-clicking the Design Manager icon on your desktop.

User Login Dialog Box
When starting Dialogue, you are prompted to enter your user name and password in the User
Login dialog box.

Login dialog box

The User Logon dialog box also displays:

• The version of the software.

• The name of the company the software is licensed to.

:: Note

When logging in, the user name is not case sensitive, but the password is case sensitive.
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

INSTALLATION AND INITIAL SETTINGS
Initial Dialogue Settings 2UNIT
An EKF is an Exstream key file 
containing a 50 to 155-character 
code. This key determines which 
features are available.
Setting Up Keys and Licensing
Upon the initial load of Dialogue, you are prompted for a key: Dialogue does not function without
a valid key.

The Dialogue Key:

• Verifies you as a customer of Exstream software.

• Enables the modules you have purchased.

• Enables the drivers you have purchased.

• Determines the amount of output you create.

• Indicates how many users may use a module per the license.

In addition to the Dialogue Key, there is a Dialogue License. The License:

• Works in conjunction with the key.

• Verifies activation of certain modules by communicating with Exstream Software.

• Verifies the number of "seats" purchased.

• Can be specific to an operating system, such as Windows or Linux-only operation.

• Can also be specific to a certain computer, using identifiers such as the MAC address.

• The Workgroup License Key enables you to use the Workgroup Engine, which can generate
production output without the demonstration banner at up to 120 pages per minute. 

– Some workgroup licenses may also be authorized to do full production output on a central 
server.  

Dialogue Keys
When purchasing Dialogue, you are provided with an EKF (Exstream Key File) file from Exstream.
This file contains your unique 50 to 155-byte system key. For your Dialogue installation to work,
you must have a valid system key.

The License Key

You are prompted to enter your system key when:

• Logging into a new or upgraded installation for the first time.

• Using a database that has just been updated using the UpdateDB utility.
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 Tip

If you do not have access to the 
Internet on the current machine, 
you must get an Electronic License 
Transfer (ELT) file from another 
machine.
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You activate a key three ways:

•  Click the  button on the above screen and browse to the .EKF file, and the EKF populates

automatically.

•  Import a key within the UpdateDB application, under the Save Database tab. 

•  You are automatically prompted for a key when logging into Dialogue when the database has
an invalid key.

Obtaining a Usage License
Your license agreement may limit the number of users for a given module or function. For
example, you are allowed three licenses for High-Volume Delivery, so you can install three
machines with this module.

The exact terms of your licensing are encrypted within your EKF. You may never use more licenses
than indicated by the EKF, until you replace the EKF.

Upon the initial login, the License option dialog box may open providing a series of methods to
specify a method to allocate the licenses allowed by your EKF. Either use the internet to obtain
your license or use a license request file provided by Exstream. 

License option dialog box

After verifying the license terms, the Request Licenses dialog box opens. This asks you which
module licenses, if any, to use for the current installation. You are given a tally of how many
licenses are currently in use and how many are available. Once you click OK, Dialogue checks with
Exstream Software. If the license is available, then it is enabled for this machine and one use for
the indicated module is deducted from the tally.

The Request License dialog box
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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For the purposes of this class, Dialogue does not require a site usage license, so this dialog box
does not appear. However, be aware that during an actual installation, you do have to set the
licensing. To install new features after a license, license commands are found in Design Manager

in the shortcut menu under Tools -> Licensing.  

                                                                                                                                                                                             

  Demonstration Observe the demonstration.
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Suites and Modules
Additions to the Dialogue software are packaged in modules that correspond to specific functions 
and features. By default, Dialogue is installed with a full suite of modules; however, only those 
activated by your system key are available for use. 

Dialogue modules
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Browse the Environment
As an administrator, you have access to the Environment heading. Normal system users do not see
this in their Library View, and they are not able to access these functions. The remainder of this
course entails mastery of these settings.

The Environment Settings in Library

In the Library, the Environment enables you access to Dialogue’s system configuration settings.
These are settings that are available only to administrative users. The subheadings under the
Environment categorize several types of system settings.

System Environment Settings
Dialogue’s System Environment Settings are located under the Environment -> System heading.

User Environment Settings in the Library

The Environment heading includes components related to users and approvals. 

By dragging the System Settings heading into the Property Panel, you access System
Configuration Options that affect system settings.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
49

Student Guide :: 
Dialogue System Administration



INSTALLATION AND INITIAL SETTINGS
Initial Dialogue Settings2UNIT
50
Student Guide ::

Dialogue System Administration
Design Environment
Dialogue’s Design Environment Settings are located under the Environment -> Design heading.

Design Environment Settings in the Library

The Design Environment controls how users design output.

Delivery Environment
Dialogue’s Delivery Environment Settings are located in the Library under the Environment ->
Delivery heading.

Production Environment Settings in the Library

The Production Environment controls how output is processed by output equipment such as
inserters and printers.
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Administering System Settings
The basic system settings are accessed by dragging the System Settings heading, under
Environment -> System to the Property Panel. There are six tabs for settings: Basic, Texts and
Fonts, Workflow, Marketing, Production Print,and License.

The system settings

Basic Tab
The Basic tab enables you to set the following options:

Setting Function

Description Describes this Dialogue system.

System Status Normal enables normal operation. Locked prevents all users
from changing anything in the system.

Login Message Whatever is entered here appears in a dialog box when any
user logs on.

Database idle disconnect 
prevention

Sets the seconds between access times to prevent you from
being disconnected from the database due to inactivity. 0
disables this setting.

System Configuration Enables you to customize the graphic user interface and the
availability of Dialogue functions for users.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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If system status is locked, you can 
use a login message to inform 
users.
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Security
This tab enables you to set the password and authentication settings for design users.

Text and Fonts
This tab enables you to set the system design defaults, or the standard font conventions for
anything created in the system without a style sheet. This topic is covered at length in the Design
Environment lesson.

Workflow
The Workflow tab sets options to control the approval process and versioning.

Marketing
The Marketing tab is available only if you have the Campaign Management module. On this tab,
choose up to three company-specific data fields that are tracked in your campaigns.

Production Print
Production Print enables you to specify Resource naming conventions for images, fonts, and
Metacode IDEN to specify a string for Metacode or AFP output.

Key
The Key tab shows your current 50-character EKF code and what options are available. You also
use this screen to browse to a different EKF file, or to modify the EKF code.

Setting Function

Passwords Sets the expiration date, minimum password length, and
maximum login failures allowed for all passwords.

External user 
authentication

Sets alternative login authentication methods. You may use
Windows authentication or a custom DLL to verify passwords
instead of checking against the DIalogue user password.

Setting Function

Edit Control If an object becomes unreferenced, Dialogue inquires whether
to delete the item or not.

Versions and approval Indicates how many versions of each object to save, and how
the system notates submissions for approval.

Regulatory support This option is only available if you have the Regulatory module.
Specifies a home locale, and how to handle cloned objects that
have regulatory assignments.

Email The E-mail server settings, which are required for the approval
notification E-mails.

If you modify your EKF code, Dialogue will not function correctly.
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Setting System Configuration
Dialogue’s interface and features are customizable to meet the specific needs of your
organization. The System Configuration dialog box, available by clicking the System Configuration
button on the System Settings Property Panel, enables you to enable or disable Dialogue
functions and features. Only the features and functions that are part of modules you have
purchased are active on the System Configuration dialog box. 

System configuration

Certain options on the System Configuration dialog box are hierarchical. If you disable an option
that is already in use in your system, it remains in use in existing designs. However, when an option
is disabled, it cannot be used in future designs. When options are disabled for a user group, those
users cannot change objects controlled by the disabled options, but the objects remain intact.

Interface Configurations

:: Note

This course describes the functions and features of a fully configured system.

Category Controls

Design Manager The appearance of objects in the Library.

Data The appearance of variable and data file features.

Content The appearance of page, document, campaign, and message features.

Workflow The appearance of packaging and workflow features.

Designer The appearance of Designer objects and features.

Key Features based on the modules available for your organization.

  Demonstration Observe the demonstration.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Independent Exercises: Initial 
Dialogue Settings

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Locate the system administrator name and password, and then logon to
Design Manager as the administrator. Then customize the system
configuration as indicated.

Task Specifics

Locate the system administrator
login and password

• Use the Readme.txt file in the Exstream installation
directory.

Log into Design Manager and
connect to the Vivanet database

• Double-click the Dialogue Design Manager icon on
your desktop.

• Enter the system administrator login and password and
click OK.

Customize the system 
configuration.

• Access the System Configuration dialog box for the
system.

• Clear the Components and Rules Library check boxes,
and then save the configuration. Observe the result.
Then restore these two settings.

• Enable Jurisdictions.

 Success! You have completed the Initial Dialogue Settings exercises.
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Guided Exercises: Initial Dialogue 
Settings

Locate the System Administrator Login and Password

In Windows:

 Your Turn Locate the default system administrator login and password.

Step Action Display

1. Open Windows Explorer. Windows

2. Browse to C:\Program Files\Exstream. Windows Explorer

3. Double-click the Readme.txt file

The file opens with the default text reader application.

4.
Scroll down to the User Login IDs section 
and locate the ADMIN login and password.

 Success! You have located the system administrator login and password.
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Log into Design Manager and connect to Database

In Windows:

The user name and password are accepted you are logged in to Design Manager and connected
to the Vivanet Database.

 Your Turn
Log in to Design Manager as the administrator by accessing the User 
Logon dialog box.

Step Action Display

1.
Double-click the Design Manager shortcut on 
the desktop.

Windows

The User Logon dialog box for Design Manager opens.

2.
Enter the system administrator user name in 
the User text box.

User Logon dialog box

3.
Enter the system administrator password in the 
Password text box.

4. Click OK.

5. Select File -> Change Database

6. Click the Vivanet Database Select Database dialog box

7. Click OK

8. Log in to Design Manger. User Logon dialog box

 Success! You have accessed the User Logon dialog box and logged in to Design 
Manager using the system administrator login and password.
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Customize the System Configuration

In Design Manager:.

 Your Turn
Demonstrate the customized system interface by turning access to 
Components and the Rules Library off. Then re-activate these options, 
and activate Jurisdictions.

Step Action Display

1.
Browse to Environment -> System -> System 
Settings.

Library

2.
Drag the System Settings heading into the 
Property Panel.

The system settings opens in the Property Panel.

3. Click the System Configuration button. Property Panel

The System Configuration dialog box opens.

4. Browse to the Design Manager tab. System Configuration dialog box

5. Clear the Component Library check box.

6. Clear the Rule Library check box.

7. Click OK.

8. Click the  button. Library

The Component and Rule Library headers disappear from the Library.

9. Click the System Configuration button.

The System Configuration dialog box opens.

10. Select the Component Library check box.

11. Select the Rule Library check box.

12. Select the Allow User Fonts check box.

13. Select the Currency Conversion check box.

14. Select the Jurisdictions check box.

15. Click OK.

16. Click the  button and exit the Property 

Panel.

The Component and Rules headers reappear and the Jurisdictions heading appears in the 
Library.

 Success! You have demonstrated the customized system interface.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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If Jurisdictions are already 
enabled, leave the box selected.
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For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



Unit Summary Concepts and Exercises

– Dialogue Installation

– Initial Dialogue Settings

Unit Summary
The concepts discussed and knowledge obtained during this unit are used in the next unit. If you
have any questions, be sure to ask your instructor during this unit summary.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
59

Student Guide :: 
Dialogue System Administration



INSTALLATION AND INITIAL SETTINGS
Unit Summary2

60

UNIT

Student Guide ::
Dialogue System Administration
Concepts and Exercises

Dialogue Installation

Initial Dialogue Settings

Concept Exercises

Dialogue Installation Process • Copy and Rename the Database

System DSN • Set up a System DSN

Updating the Database • Update the database

Concept Exercises

Accessing Dialogue Design 
Manager

• Locate the System Administrator Login and Password

• Log into Dialogue Design Manager

Customizing the System 
Configuration

• Customize the System Configuration
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• General User Access

• Creating Folders

• Approvals

• Defining Languages and Locales

• Jurisdictions

• Unit Summary
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General User Access Creating Users and Super Users

– Creating and Defining Users

– User Properties

– Creating and Defining Super Users

Creating Design Groups and Adding 
to Design Groups

– Setting Access Rights

– Creating Design Groups

– Adding Users to a Design Group

Customizing the Design Group 
System Configuration

Independent Exercises

Guided Exercises

– Creating Users

– Create a Super User

– Identify the User Access Rights

– Create a Design Group

– Create an Administrative Design 
Group

– Add Users to Design Groups

– Customize the Design Group System 
Configuration

– Restore the Design Group System 
Configuration

General User Access
To set up your organization in Dialogue, you create users and design groups to enhance
collaboration, enforce security, and streamline workflow.

This lesson provides the process by which you create users and design groups and configure
design group access levels.

Objectives
By the completion of this lesson, you will be able to:

• Create users and super users.

• Create design groups and add users to groups.

• Identify user access rights.

• Customize the design group system configuration.

Terms
New terms used in this lesson include:

• Departmental access - Access rights that are part of the functional access for a design group.

• Functional access level - An area of a design group’s properties used to specify access to users
and design groups to certain system functions.

• Super user - A Dialogue user with the highest administrative permission levels or all access
rights.

• User - A person who accesses Dialogue.

• Design Group - A list of one or more users and/or other design groups.

Additional Information
For more information on this topic, refer to the Dialogue: 

• System Administration Guide.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A user is a person who accesses
Dialogue.
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Creating Users and Super Users
Anyone who works in Dialogue is defined as a user.

When creating a user, you define:

• Name and description.

• Password information.

• Login status.

• E-mail and approval notification options.

Creating and Defining Users
Create a new user by browsing to Environment -> System -> Design Users, right-clicking on the
heading and selecting New User.

Creating a new design user

:: Note

A user’s functional access is defined by its membership in a design group.
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After giving a name and description, you are prompted for the user properties.

Creating a new user

User Properties
There are a variety of settings that are used to further define the user. These settings are defined in
the Property Panel. Each profile contains the following information.

Property Setting Function

Description Describes the user’s function.

Super user Identifies the user as a super user: grants unlimited access. If
this box is cleared, the user reverts to the previously defined
access levels.

Password The user’s password authenticates the user identity.

Days until password expires The system requests a new password from the user after this
interval elapses.

Use system default The system default is used for password renewal.

Password last changed on The date and time of the last password change.

Force password change on 
next login

The system requires the user to change the password during
the next login.

Login disabled The system does not allow this user to login.

Last login The date and time when this user last logged in.

E-mail address The user’s E-mail address for receiving approval notifications.

Receive pending approval 
notifications

The user receives an E-mail when there is a new document in
the system that requires the user’s approval. (Enterprise
Workflow Module only)

Receive rejection 
notifications

The user receives an E-mail when a document has been
rejected. The user must be a member of the approval process.
(Enterprise Workflow Module only)
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A super user is a user with the 
highest administrative permission 
levels or all access rights.
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Super Users
A super user is a user who has full access to Dialogue. A super user:

• Has no restrictions on system access.

• Can add, modify, or delete anything.

• Can approve all objects submitted.

Super user access may be removed at any time. When a user is no longer defined as a super user,
that user is reverted to the last defined permission settings.

Creating and Defining a Super User
Create a super user by browsing to Environment -> System -> Design Users, right-clicking on the
heading and selecting New User.

Creating a super user

After giving a name and description, you are prompted for the user properties. By selecting the
Super user option, the user is set up as a super user.

Defining a super user
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A design group is a list of one or 
more users and/or other design 
groups. Each design group object 
defines access to Dialogue 
features and functions for multiple 
users. design groups also classify 
similar employees. and define the 
availability of Dialogue objects.

 Tip

While granting Environment access 
allows the users of that group to 
access administrator objects, only 
a super user may modify users, 
design groups, and system 
configuration.

A functional access level is an area 
of a design group’s properties used 
to specify access to users and 
design groups to certain system 
functions.
Creating Design Groups and Adding 
Design Users to Design Groups
Often many users share purposes or access needs. Therefore, it is advantageous to classify the
users into design groups. Design groups accomplish two key ends: 

• Classify similar employees. 

• Define the availability of Dialogue objects.

For instance, create a different design group for Marketing, Sales and Production. This way, you
provide a folder for each group, containing only the objects they need for their job. 

Many users: many functions 

Setting Access Rights
Before defining design groups, be aware of each group’s function and which areas of Dialogue the
design group needs to access. Design group access settings include:

Functional access levels
Each of these areas has a functional access level. For example, if your design group had the
Campaign design access state set to None, the Campaign headings does not appear in the
Library view. If a user does not have at least the View access level for an area, the related item does
not appear in Design Manager.

Area Affected Functionality

Environment Enables the users in the group to access the administrative
functions (below the Environment heading). Enable this option
only for design groups with administrative access.

Data Enables the users in the group to create and modify data files,
control files, and batch files.

Application design Enables the users in the group to create documents, pages,
messages and objects.

Campaign design Enables the users in the group to create campaigns.

:: Note

A user may belong to many groups. Conflicting group rights do not negate each other. If a user
belongs to two groups, and one group restricts a function, and the other grants the same
function, the user has access to the function.
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Departmental access further 
define access rights that are part of 
the functional access for a design 
group.
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Functional Access Levels

Departmental Access
In addition to the functional access levels, each design group also has departmental access:

Functional 
Access Level See Change Add Erase

None

View

Revise

Create

Create and Delete

Rule Enables

Folder Administration The users may create and delete new folders where their design
group has at least Revise access.

Edit Rules The users may create and edit rules that apply to paragraphs,
sections, messages, campaigns, documents and queues where
their design group has at least Revise access.

Edit Content The users may create and edit paragraphs, sections, messages,
campaigns, documents and queues where their design group
has at least Revise access.

Edit Style The users may add, modify, or delete styles and style sheets.

Approver The users are included in the approval process for the
applicable items in the home folder.

Workflow Administration The users are allowed to submit items for review, pending the
approval process assigned to the current folder.

Super User Designates every user in this design group as a super user.
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Creating Design Groups
Creating a design group is the first step in setting the access levels for a group of users. You also
set the starting folder and customized user interface options during this process. Upon creation,
the design group opens in the Property Panel for you to define.

Create a new design group by browsing to Environment -> System -> Design Groups, right-
clicking on the heading and selecting New Design Group. After giving a name and description, fill
out the properties.

Creating a new Design Group

After giving a name and description, you are prompted for the properties.

You add users to design groups and define permissions with these properties.

Design Group properties
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 Tip

A design group may contain as 
many users and sub-design groups 
as you want.

 Tip

Design users and design groups  
may also be specified by an 
external .DLL. Refer to the 
Dialogue documentation for more 
details.
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Adding Users to a Design Group
Once you have created a design group, you must add users and set permission levels for the
design group.

Adding users

Design Groups
Either populate the design group by using users and groups already defined in Dialogue, or by
adding users and design groups defined by your operating system network. Add items to the lists

by clicking on the  button; remove items from the lists by clicking the  button.

Design groups

Design groups may be added using the network authentication or a custom DLL file containing 

the design group information.

List Description

Users included in group Users defined in Dialogue.

Groups included in group Design groups defined in Dialogue; may contain sub-groups.

System users included in
group

Users defined in your network, not in Dialogue.

System groups included in
group

Design groups defined in your network, not in Dialogue.

:: Note

Refer to Unit 2: Installing Dialogue for more information about logging into Dialogue
without a design user profile.

User lists

Design group configuration

Functional access levels

Access rules
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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 Tip

While super users disregard group 
limitations, they do not disregard 
the group’s configuration settings. 
Customizing the User Group System 
Configuration
You also specify the configuration settings for each design group by clicking on the  Configuration
button. This feature enables you to enable or disable certain functions, regardless of access level,
or even super user access. This is different from customizing the System Configuration, which
affects every design user, regardless of design group membership. 

Customized user interface settings

In conjunction with design group membership, a customized user configuration restricts the 
design user to only the functions necessary for that user’s role.

Design Group Configuration

These settings supersede access levels. So if your design group had View permissions to
Components, and Design Manager was disabled in the Design Group Configuration settings, you

would not be able to access any Library components.

Category Description

Design Manager Controls the appearance of objects in the Library.

Data Controls the appearance of variable and data file features.

Content Controls the appearance of page, document, campaign, and message
features.

Workflow Controls the appearance of packaging and workflow features.

Designer Controls the appearance of Designer objects and features.

Key Controls features based on the modules available for your organization.

:: Note

A design user must belong to a design group to be eligible for the design group configuration.
If a user is not a super user and the user is not a member of some group, the user has no access
rights.
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  Demonstration Observe the demonstration.
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Independent Exercises: General 
User Access

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Set up the design users and design groups within Dialogue, and then
customize the user system configuration.

Task Specifics

Create users • Create a user for Fred Drake, Jim Smith, James 
Wilcher, Steven Maxwell, Roy Ferris, and yourself.

Create a super user • Set Roy Ferris and yourself as super users.

Identify user access rights • Identify the functionality granted for each access 
setting. In the table below, place an X in each cell that 
applies.

Create design groups • Create a design group for each organization within 
Vivanet. Set the access levels to create and delete for 
all areas, except Environment. Set the Environment to 
None.

Add users to design groups • Add all users to the appropriate design groups.

• Add yourself and Roy Ferris to the IT group.

Customize the design group 
Configuration

• Turn off the following options for your design group 
configuration: Color Families and Design Layers.

• Refresh your Library and observe the result.

• Restore the options.

• Refresh your Library and observe the result.

Access Setting See? Change? Add? Erase?

View

Create

Create and Delete

Revise

None

 Success! You have completed the General User Access exercises.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Guided Exercises: General User 
Access

Create Users 

In Design Manager:

 Exercise Create six new users in Dialogue: one for everyone department head in 
the Vivanet organization, and one for Roy Ferris.

Step Action Display

1.
Browse to Environment -> System -> Design
Users

Design Manager

2.
Right-click the Design Users heading and
select New User from the shortcut menu.

The New Design User dialog box opens.

3. Type Fred Drake in the Name text box. New User dialog box

4.
Type Fred Drake - Corporate in the
Description text box.

5. Click Finish.

The new user opens in the Property Panel for you to define

6. Enter drake in the Password field. Property Panel

7.
Enter drake@vivanet.com in the E-mail address
field.

8. Click the  button.

9. Add the remaining users indicated by your note from John. There will be 6 in all.

 Success! You have created dic users in Dialogue.
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Create a Super User 

In Design Manager:

 Exercise Create Roy Ferris as a super user.

Step Action Display

1.
Browse to Environment -> System -> Design
Users

Library

2. Right-click Roy Ferris.

3. Select Properties from the shortcut menu.

The user properties opens in the Property Panel.

4. Select the Super user check box. Property Panel

5. Click the  button.

 Success! You have created Roy Ferris as a super user.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Identify User Access Rights

You have identified the functionality granted to each of the five access settings.

 Exercise Identify the functionality granted for each access setting. Place an X in 
each cell that applies.

Access Setting See? Change? Add? Erase?

View

Create

Create and Delete

Revise

None

 Success! You have identified all user access rights.
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Create Design Groups

In Design Manager:.

 Exercise
Create four design groups, one for each organization within Vivanet, 
except Information Technology. Every group should have create and 
delete access for Data, Application Design and Campaign Design, and 
no access for Environment. 

Step Action Display

1. Browse to Environment -> System -> Design Groups Library

2.
Right-click the Design Group heading and select
New Design Group from the shortcut menu.

The New Design Group dialog box opens.

3.
Type Corporate in the Name text box New Design Group dialog

box

4. Type a description in the Description text box.

5. Click Finish.

The design group opens in the Property Panel for you to define

6. Select None from the Environment drop-down list. Property Panel

7.
Select Create and delete from the Data drop-down
list.

8.
Select Create and delete from the Application
Design drop-down list.

9.
Select Create and delete from the Campaign Design
drop-down list.

10. Click the  button.

11.
Add Production, Sales, and Marketing design groups indicated by your note from
John.

 Success! You have created four design groups.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

77

Student Guide :: 
Dialogue System Administration



SETTING UP THE SYSTEM ENVIRONMENT
General User Access3UNIT
78
Student Guide ::

Dialogue System Administration
Create an IT Design Group

In Design Manager:.

 Exercise Create an IT design group with create and delete access for all areas. 
Also, enable all other areas of functional access.

Step Action Display

1. Browse to Environment -> System -> Design Groups Library

2.
Right-click the Design Group heading and select
New Design Group from the shortcut menu.

The New design group dialog box opens.

3.
Type IT in the Name text box New design group dialog

box

4. Type a description in the Description text box.

5. Click Finish.

The design group opens in the Property Panel for you to define

6.
Select Create and Delete from the Environment
drop-down list.

Property Panel

7.
Select Create and Delete from the Data drop-down
list.

8.
Select Create and Delete from the Application
Design drop-down list.

9.
Select Create and Delete from the Campaign Design
drop-down list.

10. Select Folder administration.

11. Select Edit rules.

12. Select Edit content.

13. Select Edit style.

14. Select Approver.

15. Select Workflow Administration.

16. Select Compliance.

17. Select Super user.

18. Click the  button.

 Success! You have created an IT design group.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Add Users to Design Groups

In Design Manager:

 Exercise Add the users to the design groups indicated by the Organization 
Chart.

Step Action Display

1.
Browse to Environment -> System -> Design
Groups

Library

2.
Drag the Corporate design group into the 
Property Panel

The Corporate design group opens in the Property Panel.

3. Click the  button under Users included in 
group.

Property Panel

The Select an item to add to the list dialog box opens.

4. Select Fred Drake from the list.
Select an item to add to the list 
dialog box

5. Click OK.

The user is added to the design group.

6. Click the  button.

7.
Add the remaining users to the appropriate
design groups.

8.
Add yourself and Roy Ferris to the IT design
group.

 Success! You have added the employees of Vivanet to design groups.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Customize the Design Group System Configuration 

In Design Manager:

 Exercise
Turn off the following Library Interface options for your design group:
Color Families and Design Layers. 

Step Action Display

1.
Browse to Environment -> System -> Design
Groups.

Library

2. Double-click the IT design group.

3. Click the Configuration button. Property Panel

The System Configuration dialog box opens.

4. Browse to the Design Manager tab.

5.
Clear the following options under Objects: 
Color Families and Design Layers.

System Configuration dialog box

6. Click OK.

7. Click the  button. Design Manager

8.
Expand the Design heading under 
Environment.

Library

The Library view has changed: Color Families and Design Layers are gone.

 Success! You customized your user interface as indicated.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Restore the Design Group System Configuration 

In Design Manager:

 Exercise
Restore the following Library Interface options for your design group:
Color Families and Design Layers. 

Step Action Display

1.
Browse to Environment -> System -> Design
Groups.

Library

2. Double-click the IT design group.

3. Click the Configuration button. Property Panel

The System Configuration dialog box opens.

4. Browse to the Design Manager tab. System Configuration dialog box

5.
Select the following options under Objects: 
Color Families and Design Layers.

6. Click OK.

7. Click the  button. Design Manager

8. Make the Library active by clicking on it. Library

9. Click the  button or press F5.

The Library view has changed: Color Families and Design Layers are again available.

 Success!
You have restored the settings turned off in your customized user 
interface.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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– The Root Folder

Creating and Defining a Folder

– Defining Folder Properties

Assigning Home Folders

– Folder Hierarchy

Restricting Folder Contents

Setting Folder Access Level

– Group Access

– World Access

– Approval Process

Independent Exercises

Guided Exercises

– Create Folders

– Define Folder Properties

– Assign Home Folders

– Restrict Folder Contents

Creating Folders
Folders are used in Dialogue to organize content. A folder’s properties determine the content of
the folder and who has access to the folder.

This lesson describes the role of folders in Dialogue and how to use them to effectively separate
work groups and set access to Dialogue components.

Objectives
By the completion of this lesson, you will be able to:

• Describe folder function in Dialogue.

• Create and define folders.

• Define folder properties.

• Assign a home folder to a user group.

• Restrict folder contents.

• Set folder access levels.

Terms
New terms used in this lesson include:

• Folders - A container for a set of Library design objects.

• Folder contents - List the Dialogue objects that may be created in the present folder.

• Home folder - The folder in the Library in which you primarily work.

• Parent folders - Folders containing subfolders, which determine the subfolder’s content.

• Root folder - The top-level folder in the Library from which all other folders branch.

Additional Information
For more information on this topic, refer to the Dialogue: 

• System Administration Guide.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Folders are Library containers for 
design objects.
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Folder Function in Dialogue
Folders can be used to define a user group’s access to Dialogue objects and to divide projects or
work areas. You can also use folders to divide projects or organize components any way you wish.

Folders in Dialogue

A folder also may assign an approval process to anything inside of it. Each folder also features
access lists, which indicates the access level granted to any users browsing in the folder. 
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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The root folder is the top-level 
folder in the Library tree from which 
all other folders branch.
The Root Folder
Dialogue Design Manager arranges all folders from the Root Folder, found at the base of the
Library. In the Library’s hierarchal folder structure, this is the folder from which all other folders and
headings must branch. It directly or indirectly contains all the objects in the design database.

Root Folder
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Creating and Defining a Folder
Create a new folder by browsing to the desired location, right-clicking the folder in the Library, and
selecting New Object -> Folder. 

Creating a folder

After giving a name and description, the folder properties appear in the Property Panel.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Defining Folder Properties
After you create the folder, the new folder opens in the Property Panel for you to define. Define
each of the folder properties.

Folder Properties

Creating a folder

Option Description

Description The description of the folder.

Parent Each folder has a parent, or folder where it resides. By default,
the root is the parent folder.

Access and approval are
the same as the parent
folder

If this option is selected, the permissions are copied from the
parent folder and applied to the current folder. This includes all
world permissions, approvals and restricted features.

Approval Process This option indicates which approval process, if any, is applied
to any project or items created in this folder. (Enterprise module
only)

World Access Sets the world access level: a default access level for all users
able to access this folder. 

Group Access This option sets access for groups with permissions different
than those granted by the World Access.

Send approval/rejection
E-mail notifications.

This option activates the E-mail approval notification for all user
groups in this folder.

Contents restricted same
as parent folder

This option sets all restricted content settings identical to the
parent folder.

Restrict specified content All cleared items are not visible or accessible in this folder.
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Home folder is the folder in the 
Library in which you primarily work.

Parent folders are folders 
containing subfolders. They 
determine any sub folder’s content.
88
Student Guide ::

Dialogue System Administration
Assigning Home Folders
You can also assign a home folder to a user group, so all users belonging to that group begin in
that folder at login. Users may browse away from the home folder, and even create things in other
folders, but the user always logs into the home folder upon login. Set home folders through the
User Group Properties.

Setting Home Folder

Folder Hierarchy
Parent folders and sub-folders compose the hierarchy of folders in Dialogue. They are arranged in
a hierarchy to the Root folder. A folder’s content and access levels are patterned after a parent
folder or the folder it was created in. You may have as many levels of folders as you wish. 

Example of parent folders and subfolders

Root Folder

Parent 
Folder

Parent 
Folder

Parent 
Folder

Sub 
Folders
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Restricting Folder Contents
The folder contents determine which Dialogue objects are available within that folder. You may
restrict any objects. For example, you can create a Messages folder that contains only messages.
Within that folder, only the Messages header appears in the Library.

Use folder contents to specify which Dialogue objects can be created within the folder. If a
Dialogue object is not in the folder contents, objects of that type may not be added to that folder. 

You can restrict folder contents upon creation. You may also restrict contents by modifying the
folder, provided there are not already objects of that type existing in the folder. For example, if
Marketing creates a document called Page 1, you cannot restrict the Document Folder Content
unless you remove Page 1 first.

Folder contents and restrictions

For example, Troy Wilson is in the Marketing user group. Marketing is only involved in written
content, images, and campaigns. Therefore, all other areas are restricted for this folder. By
assigning the Marketing group to this folder, Troy sees only Paragraphs, Campaigns, Messages
and Components available. Also, any documents created by Troy are stored in this folder, not the
root folder.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Folders automatically use the same 
access level settings as the parent 
folder.
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Setting Folder Access Level
Before creating any folder, plan the access levels, operational items, and folder contents. Consider
what must be set for group access, including world access and any applicable approval processes.

World Access
World Access sets the default access settings for any users who browse to the folder. Any user who
browses to this folder is assigned these access settings, except if they are listed in the Group
Access.

Group Access
The Group Access sets exceptions to the World Access setting. This enables you to assign access
levels for specific groups instead of the World Access setting. 

For example, you may want all departments to be able to view the contents of the Marketing
folder. However, you do not want anyone but someone from the Marketing user group creating
anything in this folder. You set the folder World Access to View and add the Marketing user group
to the Group Access, with Create and Delete access. Now only Marketing users can create, delete,
or modify anything in the folder.

Approval Process
An approval process is a collaborative feature that enables other users within the group to review
and approve an object before it proceeds to the next step. This feature is covered in detail in a
later chapter.

The approval process is assigned at the folder level. If a folder includes an approval process, 

anything that a user creates in the folder is subject to approval.

:: Note

Be sure to set the World Access and Group Access levels accordingly if you do not want any
user creating objects within the folder.

  Demonstration Observe the demonstration.
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Independent Exercises: Creating 
Folders

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Create a home folder for each of the user groups, define each folder, and
then restrict the Data Files and Data Dictionary in the Marketing folder.
Finally, assign each user group to a home folder.

Task Specifics

Create folders • Create four folders: Corporate, Production, Sales, and
Marketing.

Define folder properties • Define the properties for each folder. Set the World
Access to View, and the Group Access to create, edit
and delete for the appropriate user group.

Assign home folders • Assign a home folder to each user group.

Restrict folder contents • Restrict the Marketing folder’s access to Data files and
the Data Dictionary.

 Success! You have completed the Creating Folders exercises.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Guided Exercises: Creating Folders
Create Folders

In Design Manager: 

 Exercise Create four folders, one for each Vivanet user group.

Step Action Display

1.
Right-click the root folder heading and select
New Object -> Folder from the shortcut menu.

Library

The New Folder dialog box opens.

2. Type Marketing in the Name text box. New Folder dialog box

3.
Type Marketing Home Folder in the
Description text box.

4. Click Finish.

5.
Create the Corporate, Production, and Sales
folders. 

 Success! You have created four folders, one for each of the Vivanet user groups.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Define Folder Properties 

In Design Manager:

 Exercise
Define each of the folders. Set the world access to View, and add the 
folder’s home user group into the Group access with create, edit and 
delete permissions.

Step Action Display

1. Double-click the Marketing folder. Library

The Marketing folder opens in the Property Panel.

2.
Clear the Access and approval are same as
parent folder check box.

Property Panel

3.
From the World access drop-down list select
View.

4. Click the  button in the Group access area.

The Select a group to add to the list dialog box opens.

5.
Select Marketing. Select a group to add to the list

dialog box

6. Click OK.

The Select the access to provide dialog box opens.

7.
Select the Create, edit and delete selection. Select the access to provide

dialog box

8. Click OK.

9. Click the  button.

10.
Define the Corporate, Production, and Sales
folders. 

 Success!  You have defined the folders per specifications.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Assign Home Folders 

In Design Manager:

 Exercise Assign the respective folders as the Home folder for each of the Vivanet 
user groups.

Step Action Display

1.
Browse to Environment -> System -> Design
Groups.

Library

2. Double-click the Marketing design group.

The Marketing user group opens in the Property Panel.

3.
Click the  button to the right of the Home

text box.

Property Panel

The Folders dialog box opens.

4. Expand the root folder. Folders dialog box

5. Select the Marketing folder.

6. Click OK.

The Marketing folder opens in the Home text box in the Property Panel.

7. Click the  button.

Repeat the process for the Corporate, Production, and Sales user groups.

 Success!
You have assigned the respective folders as the Home folder for each of 
the Vivanet user groups.
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Restrict Folder Contents 

In Design Manager:

 Exercise Restrict the Marketing folder access to data files.

Step Action Display

1.
Drag the Marketing folder into the Property
Panel.

Library

The Marketing folder opens in the Property Panel.

2.
Clear the Contents restricted same as parent
folder check box.

Property Panel

3.
Select the Restrict to specified content check
box.

4. Clear the Data Files check box.

5. Click the  button.

 Success!  You have defined the Marketing folder per specifications.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Setting Up Dialogue Approvals

Setting Up the Dialogue E-mail 
Approval Notification

– E-mail Settings

– Setting Approval Notification at the 
User Level

– Setting Approval Notification at the 
Folder Level

Enterprise Approval Module

Setting up an Enterprise Approval 
Process

– Approval Processes and States

– Create and Define an Approval State

– Create and Define an Approval 
Process

– Adding an Approval State to an 
Approval Process

– Assigning an Approval Process to a 
Folder

– Approval Process Notes

Independent Exercises

Guided Exercises

– Set Up the Approval System

– Enable E-mail Approval Notification

– Create an Enterprise Approval 
Process: Create Approval States

– Create an Enterprise Approval 
Process: Create an Approval Process

– Demonstrate an Approval Process

Approvals
Dialogue offers an approval system that enables you to review, approve and reject objects created
by system users. The optional Enterprise Approval Module expands the approvals functionality
and enables you to set up an even more sophisticated, multi-phase approval process.

This lesson describes how to use the Dialogue approval system. It also covers the Enterprise
Approval modules for expanding approval functionality.

Objectives
By the completion of this lesson, you will be able to:

• Identify the Dialogue approval states.

• Set up the Dialogue approvals.

• Set up the Dialogue E-mail approval notification.

• Identify the benefits of the Enterprise Approval Module.

• Create an Enterprise Approval process.

• Demonstrate an Enterprise Approval process.

Terms
New terms used in this lesson include:

• Approval criteria - The conditions for an approval state to be approved or rejected.

• Approval process - A feature used to specify the stages of approval for objects. You can create
customized approval states and define the order objects must travel through to be considered
approved.

• Approval state - User-defined steps an object must go through before being approved.

Additional Information
For more information on this topic, refer to the Dialogue: 

• System Administration Guide.

Modules
In this lesson, you will use Dialogue and the Enterprise Approval module. The Enterprise Approval
module is an optional module.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A new object is always created in 
the Work In Progress state.
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Dialogue Approvals
Dialogue features an approval process, which enables designated users to review and approve
new objects in the system before they are used. This means that anyone with the proper permis-
sions may create new objects in Dialogue, but they must be approved before used in a production
capacity.

In the Library, an object’s approval state is shown to the left of the object:

Approval status icons

The icon next to the document indicates its current status.

For example, Tony Taylor creates a new page in Dialogue. While working, the page status is Work
in Progress. When he is ready to submit it for approval, its status changes to Submitted for
approval. The manager, who was designated as approver, reviews the page and approves it. The

status of the page status changes to Approved. 

:: Technical Note

You designate approvers in your system through their user groups.

Icon Indicates Status

Approved The object has been approved and is ready for use.

Submitted for approval The object has been submitted for approval, but an
approver has not approved or rejected it yet.

Rejected The object has been rejected and may not be used
until it is resubmitted and approved.

Work in Progress The object is in progress and has not yet been submit-
ted for approval.

:: Technical Note

If a component is rejected and then resubmitted, it must restart the approval process from the
beginning.
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Setting Up the Dialogue Approvals
Setting up approvals must be done in both the System Settings and the designer group System
Configuration.

First, go into the System Settings under the Workflow tab and select Submissions for Approval
Required. Select Approval effective dates should include time (HH:MM) if desired, and select the
Number of versions to keep.

System settings

Next, you must set up approvals in the designer group system configuration under the Workflow
tab. Select the Version control and approval option to activate the approvals feature.

System configuration
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 Tip

This feature works for both 
Dialogue and the Enterprise 
Approval module. However, the 
Enterprise Approval module sends 
additional E-mail notifications.
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Next, you must set approvers for the approval process. Approvers are set in the User Group
settings, in the Functional Access area.

Setting up approvers
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

SETTING UP THE SYSTEM ENVIRONMENT
Approvals 3UNIT
Setting Up the Dialogue Approval  
E-mail Notification
You can configure the E-mail notification system in Dialogue to inform approvers and submitters
that an object’s approval status has changed. The notification informs the approvers and
submitters when:

• A new object requires approval.

• An object has attained a new status (approved or rejected).

• An object needs a new approval vote.

Notification E-mail
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E-mail Settings
Your network must have an existing, functional E-mail system to use the notification feature.
Before you set any approval notification, you must direct Dialogue to your E-mail server. Go to the
System Settings, browse to the Workflow tab, and enter the mail dynamic linked library name, and
your mail server address.

• Mail.dll Name - You may use ExstreamSMTP.dll (included with Dialogue) or you may use your
own E-mail .dll file.

• Mail server - Provide two pieces of information: first, give the name of the E-mail server. Then,
place a semicolon and the name that appears in the Sent From field. You cannot use a space in
the Mail server field.

• Send test email - This button sends a test email to verify that the settings entered are correct.

• Send approval/rejection mail notices - When selected, Dialogue will automatically send an E-
mail when an object is approved or rejected.

Dialogue E-mail settings

Setting Approval Notification at the User Level
To set the E-mail notification at the user level, open the user in the Dialogue Design Manager.
Select the Receive pending approval notifications and the Receive rejection notifications check
boxes. This enables the user to receive the E-mails.

User approval notification
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Setting Approval Notification at the Folder Level
To set up the E-mail notification at the folder level, open the folder properties in Dialogue Design
Manager. Select the Send Approval/Rejection E-mail Notifications option. This enables the system
to send the E-mails.

Folder approval notification

.

:: Note

If the user property is set, but not the folder, the system never sends the E-mail. If the folder
property is set, but not the user, the E-mail is sent, but the user never receives it.

  Demonstration Observe the demonstration.
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Enterprise Approval Module
The Enterprise Approval module enables a more sophisticated review process. This process
canvasses multiple user groups for approval before allowing a project to advance to the next
phase, instead of requiring only one approval.

For example, the Production Group is in charge of creating the newsletter, but both Sales and
Marketing need to approve this document before it is included in an application. By enabling the
Enterprise Approval, the indicated user groups have the opportunity to approve or reject a
document.

Instead of the standard approval process, an Enterprise Approval Process allows the object to pass
through many phases and states before approving. You may also use different approvers at
different states of the process.

Enterprise Approval Process Example

:: Note

Enterprise Approval is an optional module. 
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Setting Up an Enterprise Approval 
Process
The approval process fosters collaboration among a team by requiring approval from other users
before the project advances to the next level. For instance, marketing may wish to see a document
in all stages before allowing it to be published.

An approval process is composed of approval states. These approval states operate in sequence:
once the required number of reviewers have approved the document, it graduates to the next
level in the cycle. If an approval state does not get the required number of approvals, it is rejected
and expelled from the cycle. When resubmitted, a rejected document must begin from the
beginning of the approval cycle.

In the scenario provided, three distinct states of approval are requested: the Draft state, the Edit
state, and the Final state. With the Approval Process in place, a user may publish only when it has
been approved at the Final state.

Create and Define an Approval State
Create an approval state by browsing to Environment->System->Approval States, right-clicking
the heading, and selecting New Approval State. 

Creating an approval state

After giving a name and description, the description and properties appear in the Properties
Panel.

Approval state properties
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
An approval process is a feature 
used to specify the stages of 
approval for objects. You can 
create customized approval states 
and define the order objects must 
travel through to be considered 
approved.

Approval states are the user-
defined steps an object must go 
through before being approved.
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Create and Define an Approval Process
Create an approval process by browsing to Environment->System->Approval Processes, right-
clicking the heading, and selecting New Approval Process. 

Creating an approval process

After giving a name and description, the description and properties open in the Properties Panel. 

Approval process properties
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Adding Approval States to an Approval Process
Once an approval process has been created and defined, you add approval states to the process.

First, click the  button under the Approval steps selection window, and select the next step in
the process from the dialog box that appears.

Next, set the approval criteria in the Who must approve drop-down list. These are the conditions
that must be met before the approval state is met and object is allowed to advance to the next
stage.

By establishing a series of Approval States, the Approval Process is defined. The order is always
sequential. The process begins with the first state and completes once the last state is reached.

Finally, add the approvers by clicking on the  button under the Approver(s) selection window.
You only add user groups, not individual users.

Approval Setting Approval Result Rejection Result

All Every user within every user 
group listed must approve 
to move to the next step.

Rejection occurs when any 
user rejects the document at 
any stage. 

Any One approval vote moves 
the object to the next step.

Rejection occurs only if 
everyone rejects the 
document.

Some Once the required number 
of approvals has been 
obtained, the document 
moves to the next step, 
regardless of the remaining 
votes.

Rejection occurs when the 
minimum approval votes can 
no longer be met.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Assigning an Approval Process to a Folder
Any folder in the Dialogue system may be assigned one approval process. To assign an approval
process to the contents of a folder, go to the folder properties and select the Approval process
from the drop-down list.

Folder properties
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Approval Process Notes
Here are some additional notes about creating an approval process:

• The approval process is sequential. The process moves to the next state upon each approval,
and exits the process if any stage fails. You cannot return to earlier approval states.

• If an object is rejected, and then re-submitted for approval, it restarts at the beginning of the
approval process.

• You enforce the approval process by selecting Approved Only in the Versions to Include field in
the Version Labels tab of the application properties, as depicted below.

Packaging with approved versions

  Demonstration Observe the demonstration.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Independent Exercises: Approvals

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Set up the approval system. Then, demonstrate an Enterprise approval
process as detailed below.

Task Specifics

Set up the Dialogue Approvals • Enable the approval system in Dialogue.

Create an Enterprise Approval 
Process

– Create Approval States

– Create an Approval Process

• Create three approval states: Draft, Edit and Final.

• Create an approval process called Vivanet Approval 
Process out of the three states. Assign yourself as the 
approver for each state.

Demonstrate an Enterprise 
Approval Process

• Create a subfolder called Vivanet Process Test and 
apply the approval process to it. Then demonstrate the 
approval process by sending a test paragraph through 
the process.

 Success! You have completed the Approvals exercises.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Guided Exercises: Approvals 

Set Up the Dialogue Approval Process

In Design Manager:

 Exercise Enable the approval system in Dialogue.

Step Action Display

1. Browse to Environment -> System. Library

2.
Drag the System Settings into the Property
Panel.

The System Settings appear in the property panel.

3. Browse to the Workflow tab. Property Panel

4.
Select Approval effective dates should include
time (HH:MM).

5. Select Submission for Approval Required.

6. Set the Number of versions to keep to 2.

7. Click the  button.

 Success! You have enabled the approval system in Dialogue.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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The user groups, by default, have 
the Version control and approval 
option already selected in the user 
group configuration.
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Create an Enterprise Approval Process: Create Approval 
States

From Design Manager

 Exercise Create three approval states: Draft, Edit and Final.

Step Action Display

1.
Browse to Environment -> System -> Approval
States.

Design Manager

2.
Right-click the Approval States heading and select
New Approval State from the shortcut menu.

The New Approval State dialog box opens.

3.
Enter Draft in the Name field. New Approval State

dialog box 

4. Enter Draft Stage in the Description field.

5. Click Finish.

6. Click the  button.

7.
Create two additional approval states: Edit and
Final.

 Success! You have created three approval states: Draft, Edit and Final.
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Create an Enterprise Approval Process: Create an Approval 
Process

From Design Manager:

 Exercise Create an approval process called Vivanet Approval Process out of the 
three states. Assign yourself as the approver for each state.

Step Action Display

1.
Browse to Environment -> System -> Approval
Processes.

Library

2.
Right-click the Approval Process heading and select
New Approval Process from the shortcut menu.

The New Approval Process dialog box opens

3.
Type Vivanet Approval Process in the Name field. New Approval Process

dialog box

4. Click Finish.

5. Click the  underneath the Approval Steps

selection box.

Property Panel

The Select Approval State dialog box opens

6.
Select Draft. Select Approval State

dialog box

7. Click OK

8. Select Any from the Who must approve field. Property Panel

9. Click the  underneath the Approver(s) selection

list.

The New Approver dialog box opens.

10.
Select IT. Select User Group dialog

box 

11. Click the  button.

12. Add the remaining two approval states.

 Success! You have created the requested approval process.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Demonstrate an Enterprise Approval Process

 Exercise
Create a subfolder called Vivanet Process Test and apply the approval 
process to it. Then demonstrate the approval process by sending a test 
paragraph through the process.

:: Note

If your computer does not have an internet connection, you will get an error regarding email
delivery: this is normal, and will not happen in a production environment.

Step Action Display

1.
In Design Manager, create a new folder in the root
folder, Vivanet Process Test.

Library

2.
Clear the Access and approval are same as parent
folder check box.

Property Panel

3. Click the  button next to the Approval Process
field.

The Select Approval Process dialog box opens.

4.
Select Vivanet Approval Process. Select Approval Process

dialog box

5. Click OK.

6. Set World Access to Create and delete. Property Panel

7. Click the  button.

8.
Expand the Vivanet Process Test folder in the Library
view.

Library

9.
Right click the Paragraphs heading and select New
paragraph.

The New Paragraph dialog box opens.

10. Type Approval Process Test in the Name field.

11. Click Finish. New Approver dialog box

12.
Right-click the paragraph and submit the Approval
Process Test paragraph for approval.

13.

Right-click and approve the Approval Process Test
paragraph. Look at the Approval State in the upper-
right-hand corner, and note it in the  Approval,
rejection, and version notes.

Approve dialog box

14. Repeat step 14 two times.

The Approval Process Test paragraph has now been officially approved. A blue check mark is
now indicated on the Approval Process Test paragraph.

 Success! You have demonstrated the approval process.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



Defining Languages and Locales Dialogue Languages

– Dictionaries

– Exception Files

– Dates and Numeric Magnitudes

Create and Define a Language

Dialogue Locales

Create and Define a Locale

Independent Exercises

Guided Exercises

– Create a Language

– Define a Language

– Create a Locale

– Define a Locale

Defining Languages and Locales
A global market indicates a wide range of customers. Customers in different countries and regions
often speak different languages and use different currency, numeric notation, and operating
system strings. By defining languages and locales, you accommodate all these considerations.

This lesson teaches you how to define languages and locales within Dialogue.

Objectives
By the completion of this lesson, you will be able to:

• Identify the functions of Dialogue languages.

• Create and define a language.

• Identify the functions of Dialogue locales.

• Create and define a locale.

Terms
New terms used in this lesson include:

• Language - Objects located under the System heading that enable you to define properties
(such as months and days) for languages in Dialogue.

• Locale - A region you define in Design Manager under the System heading that specifies
language, currency, and date formats.

Additional Information
For more information on this topic, refer to the Dialogue: 

• System Administration Guide.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A language is an object located 
under the System heading that 
enables you to define properties 
(such as months and days) for 
languages in Dialogue.
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Dialogue Languages
To avoid confusion, indicate which language a region speaks. For example, Belgian clients speak
French, while Austrian clients may speak German. In addition to communication differences,
languages also have different ways of expressing dates and large volume numbers.

Languages in Dialogue assist with verbal expressions. Languages are used to specify spelling
dictionaries, days of the week, months of the year, exception files, and for expressing large
numeric magnitudes.

Languages have different ways of expressing days and volumes.

Spelling Dictionaries
Dialogue contains several dictionaries (if installed), which enable you to check for proper spelling
as dictated by the language. The dictionary does not contain word meanings -- it is only a catalog

of the preferred spellings of major words. 

Exception Files
Exception files contain special words that ignore the dictionary’s conventions for spelling. There
are two kinds of exception files: Hyphenation and Case Conversion.

Hyphenation
There may be exceptions to the hyphenation rules for this language. For example, you may want
the words all in one to appear as "all-in-one." By including this spelling in your exception file, it
changes any instance of "all in one" to "all-in-one."

:: Note

A language in Dialogue is not a language layer, although a language layer is based on a
language.

:: Note

The dictionaries must be installed prior to use. You select the dictionaries during installation.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Case Conversion
There may be exceptions to letter case rules for this language. For example, the name Mcdonald
may be spelled as McDonald. By including this spelling in your case conversion exception file, it
arranges the letter cases as indicated.

Dates and Numeric Magnitudes
Languages have different ways of expressing the date and high numeric magnitudes. Therefore,
express the days of the week (full name and shorthand), months of the year (full name and
shorthand), and the method of expressing large numeric magnitudes such as thousands, millions,
and billions for each language.

Value English French

Months January [Jan], February 
[Feb]

Janvier [Jan], Fébrier [Féb] 

Days of the Week Monday [Mon], Tuesday 
[Tue]

Lundi [Lun], Mardi [Mar]

Numeric Magnitude: 
1,000

Thousand Mille

Numeric Magnitude: 
1,000,000

Million Million

Numeric Magnitude: 
1,000,000,000

Billion Millard
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Create and Define a Language
Create a new language by browsing to Environment -> System -> Languages, right-clicking the
heading, and selecting New Language. 

Create a language

After giving a name and description, you complete the language properties.

Language properties

  Demonstration Observe the demonstration.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A locale is a region you define in 
Design Manager under the System 
heading that specifies language, 
currency, and date formats.

 Tip

If you use a foreign locale, update 
your currency conversion often.
Dialogue Locales
Simply translating the language is often not enough to provide a publication in that locale. Locales
assist while expressing numeric expressions such as money notation, decimal notation and date
formatting. 

For example, America and England both speak English, but there are a number of differences:

When defining a locale, you must provide information regarding:

• Language - The spoken language of the region. For example, France, Haiti, and Luxemburg all
speak French.

• Date format - The preferred date notation for the region. For example, European nations favor
using the dd/mm/yy format, whereas Americans commonly use the mm/dd/yy format.

• Test Operating System String - Specifies an operating system string unique to that locale.

• Production Operating System String - Specifies a production operating system string unique to
that locale.

• Symbol - The shorthand notation for the basic unit of currency. For example, $ is used to denote
both dollars (United States) and Euros (France and Greece).

• Decimal Format - Some locales have different methods of denoting large numbers and uses for
decimals. Enter the decimal format here.

• Currency Convert - Enter the current exchange rate (based on the United States Dollar) for this
currency. 

When a locale is specified, all of these attributes are appropriately modified in the document. For 
example, monetary data opens properly converted and denoted in the locale’s currency.

ITEM United States United Kingdom

Language English (American) English (British)

Money Dollars ($) Pounds (£)

Date Format 12/30/2005 30/12/2005
119
Student Guide :: 
Dialogue System Administration



SETTING UP THE SYSTEM ENVIRONMENT
Defining Languages and Locales3UNIT
120
Student Guide ::

Dialogue System Administration
Create and Define a Locale
Create a new locale by browsing to Environment -> System -> Locales, right-clicking the heading
and selecting New Locale. After giving a name, description, and language, you may fill out the
properties.

Create a locale

After you provide a name and description for a locale, you are prompted for the locale’s language.

Locale language
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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After providing the language, the locale properties appear in the Property Panel.

Locale properties

  Demonstration Observe the demonstration.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Independent Exercises: Defining 
Languages and Locales

If you need help, refer to the steps provided in the following Guided Exercises.

   Exercise
Create a Spanish language and a Mexico locale for Vivanet’s latest client, 
Presidente Communications.

Task Specifics

Create and define a language • Create an entry for Spanish.

• Set the Spanish dictionaries.

• Define the Spanish days of the week. 

• Define the Spanish months of the year. 

Create and define a locale • Create a locale for Mexico.

• Define the currency characteristics for Mexico. 

• Define the numeric magnitudes for Mexico. 

 Success!
You have completed the Defining Languages and Locales 
exercises.
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Guided Exercises: Defining 
Languages and Locales

Create a Language

In Design Manager: 

   Exercise Create Spanish as a language in Dialogue.

Step Action Display

1. Browse to Environment -> System -> Languages Library

2.
Right-click the Languages heading and select New 
Language from the shortcut menu.

The New Language dialog box opens.

3. Enter Spanish in the Name field. Property Panel

4. Enter Spanish in the Description field.

5. Click Finish.

 Success! You have created an instance of the Spanish language in Dialogue.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

123

Student Guide :: 
Dialogue System Administration



SETTING UP THE SYSTEM ENVIRONMENT
Defining Languages and Locales3UNIT
124
Student Guide ::

Dialogue System Administration
Define a Language

In Design Manager: 

   Exercise Define the attributes of the Spanish Language.

Step Action Display

1. Browse to Environment -> System -> Languages Library

2. Double-click Spanish.

The Spanish (Language) screen opens in the Property Panel

3. Select Spanish in the Dictionary drop-down list. Property Panel

4. Select Spanish in the Language drop-down list.

5. Enter the Spanish Months of the year.

6. Enter the Spanish Days of the Week.

7. Enter mil in the Thousands field.

8. Enter millón in the Millions field.

9. Click the  button.

 Success! You have defined an entry for the Spanish Language in Dialogue.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Create a Locale

In Design Manager:

   Exercise Create a locale for Mexico.

Step Action Display

1. Browse to Environment -> System -> Locales Library

2.
Right-click the Locales heading and select New 
Locale from the shortcut menu.

The New Locale dialog box opens.

3. Enter Mexico in the Name field. New Locale dialog box

4. Enter Mexico in the Description field.

5. Click Next.

6. Select Spanish from the Language drop-down list.

7. Click Finish.

The Mexico (Locale) screen opens in the Property Panel.

 Success! You created the Mexico locale.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Define a Locale

In Design Manager:

   Exercise Define the Mexico locale in Dialogue.

Step Action Display

1. Browse to Environment -> System -> Locales Library

2. Double-click Mexico.

The Mexico (Locale) screen opens in the Property Panel.

3. Select dd.mm.yyyy (06.04.2001) in the Date Format
drop-down list.

4. Enter 0.09 in the Currency Conversion field.

5. Select . in the Thousands field, under Currency
format.

6. Select , in the Decimal field, under Currency format.

7. Select (1$) in the Negative field, under Currency
format.

8. Select 1$ in the Positive field, under Currency
format.

9. Enter 2 in the Digits field, under Currency format.

10. Enter 2 in the Digits field, under Default floating
format.

11. Enter , in the Decimal field, under Default floating
format.

12. Enter -xxx.xxx in the Negative field, under Default
floating format.

13.
Click the  button.

 Success! You have defined the Mexico locale.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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– Jurisdictions and Data

– Identifier

– Effectivity Dates

Create and Define a Jurisdiction

Independent Exercises: Jurisdictions

Jurisdictions
Jurisdictions are geographic or virtual locations for the distribution of communication. For
example, you may wish to send special messages to clients in one particular city or state. You do
this by using Jurisdictions.

This lesson covers how to define Jurisdictions within Dialogue.

Objectives
By the completion of this lesson, you will be able to:

• Describe the roles of Jurisdictions in Dialogue.

Terms
New terms used in this lesson include:

• Jurisdiction - A geographic or virtual location for the distribution of communication.

Additional Information
For more information on this topic, refer to the Dialogue: 

• Effectivity and Jurisdictions Guide.

• System Administration Guide.

Modules
• In this lesson, you will use the Dialogue pDriver and eDriver suites. These suites are not included

with Dialogue.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A Jurisdiction is a geographic or 
virtual location for the distribution 
of communication.

 Tip

Jurisdictions may contain other 
Jurisdictions. For example, a state 
Jurisdiction contains several cities. 
This is a group Jurisdiction.
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Jurisdictions
Jurisdictions are useful when dealing with different regions such as states. For example, the laws
and policies for one state may vary from a neighboring state. Also, you may wish to convey a
different message to clientele in a certain region. To accomplish this distinction, create
Jurisdictions.

Jurisdictions can be extremely broad, or very specific: 

• Global Region - The Western Hemisphere

• Continental - North America

• Country - The United States

• Regional - The Western United States

• State - California

• City - San Francisco

• City Region/Suburb - Fisherman’s Wharf

• Complex - The Embarcadero

Thus, you target all clients that are located in the Western Hemisphere, down to only the clients
who are located at The Embarcadero in San Francisco.

Objects may be limited by Jurisdiction:

• Documents

• Pages

• Sections

• Paragraphs

• Messages

Some examples of Jurisdictions:

• An insurance company includes an extra page addendum to all Kentucky residents, describing
the new changes in Kentucky Insurance laws. This Jurisdiction is State level.

• A phone company includes a customized image message on the bill, depending on the city of
the client. This Jurisdiction is City level.

• A cable company includes a paragraph to notify clients of upcoming maintenance for all clients
in the Kendall suburb of Miami. This Jurisdiction is City Region/Suburb level.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Jurisdictions and Data
Aside from establishing a customer’s location, a Jurisdiction is also used to determine what kind of
content needs to be presented. For example, Vivanet customers in Lexington are not concerned
with laws affecting Frankfort, but directly affected by Lexington laws. You can use Jurisdictions to
map the appropriate information from a larger document.

Therefore, you pull out the text that is relevant only to Lexington contracts, or information that is
relevant to Frankfort contracts. The driving data for this selection is the Identifier.

Identifier
The key to assigning a Jurisdiction is the identifier. The identifier is the field each record is
evaluated against to determine if it belongs in the current Jurisdiction. For example, if your
Identifier was WY, then anything labeled with a WY is included. Map your Identifier to the
Sys_CustomerJurisdiction variable.

Effectivity Dates
To set a Jurisdiction, the object must have a Regulatory Support tab. Then you must set the
Effectivity of the Jurisdiction. In other words, when does the Jurisdiction go into effect and when
does it expire? These details are configured in the Setting Jurisdicition Effectivity field.

Once you have configured the identifier and effectivity, the Jurisdiction is ready for use.

Setting Effect

All Jurisdictions have the
same dates

This Jurisdiction has no specific effectivity details.

Enable for those listed This object opens if the client belongs to the Jurisdiction.

Disable for those listed The object does not appear if the client belongs to the
Jurisdiction.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

129

Student Guide :: 
Dialogue System Administration



SETTING UP THE SYSTEM ENVIRONMENT
Jurisdictions3UNIT
130
Student Guide ::

Dialogue System Administration
Create and Define a Jurisdiction
Create a new Jurisdiction by browsing to Environment -> System -> Jurisdictions, right-clicking
the heading, and selecting New Jurisdiction. 

Create a Jurisdiction

After giving a name and description, fill out the properties.

Jurisdiction properties
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Independent Exercises: 
Jurisdictions

If you need help, refer to the steps provided in each corresponding exercise.

 Exercise This is a group discussion.

Task Specifics

Discuss Jurisdictions Discuss how Jurisdictions can be used in your current
environment.

 Success! You have completed the Jurisdictions exercises.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Unit Summary Concepts and Exercises

– General User Access

– Creating Folders

– Approvals

– Defining Languages and Locales

– Jurisdictions

Unit Summary
The concepts discussed and knowledge obtained during this unit are used in the next unit. If you
have any questions, be sure to ask your instructor during this unit summary.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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Concepts and Exercises

General User Access

Creating Folders

Approvals

Concept Exercises

Creating Design Users • Create a Design User

Create a Super User • Create a Super User

Design Groups • Identify the User Access Rights

• Create a Design Group

• Create an Administrative Design Group

• Add Users to a User Group

Custom User Interface • Customize the Design Group System Configuration

• Restore the Design Group System Configuration

Concept Exercises

Folders • Create a Folder

• Define Folder Properties

• Assign Home Folders

• Restrict Folder Contents

Concept Exercises

Dialogue 1:1 Approvals • Setting Up the Dialogue 1:1 Approvals

Enterprise Approval Module • Create an Enterprise Approval Process: Create Approval
States

• Create an Enterprise Approval Process: Create an
Approval Process
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Defining Language and Locales

Jurisdictions

Concept Exercises

Languages • Create a Language

• Define a Language

Locales • Create a Locale

• Define a Locale

Concept Exercises

Jurisdictions • Discuss the application of jurisdictions.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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• Fonts, Styles, and Style Sheets

• Colors, Paper Types, and Design Layers

• Tag Sets and Page Templates

• Message Types and Message Templates

• Unit Summary

Unit 4 ::
Setting Up the Design

Environment





Fonts, Styles, and Style Sheets Administering Fonts

– Adding a Font

– Limit Font Usage

– Deactivating a Font

– Allowing User Fonts

 Setting System-Wide Design Defaults

– Design Resolution

– Indent

– Bullets and Numbering

Styles

Create and Define a Style

Create and Define a Style Sheet

– Planning a Style Sheet

Create and Define Style Sheets

– Adding Styles to Style Sheets

– Enforcing Style Sheets

Independent Exercise

Guided Exercise

– Add a Font

– Add a Restricted Font

– Set Up Design Defaults

– Create a Text Style

– Create Paragraph Styles

– Create a Style Sheet

Fonts, Styles, and Style Sheets
Most companies value consistency and therefore set guidelines for publishing documents. By
enforcing a style guide and setting standards for publication, the documents have a professional,
streamlined appearance. This lesson describes how to administer fonts, styles, and style sheets in
Dialogue.

Objectives
By the completion of this lesson, you will be able to:

• Administer fonts, including:

– Adding fonts.

– Limiting font usage.

– Deactivating fonts.

– Allowing user fonts.

• Set system-wide design defaults, including:

– Design Resolution.

– Indent.

– Bullets and Numbering.

• Identify the benefits of using a style in Dialogue.

• Create styles.

• Identify the benefits of using a style sheet in Dialogue.

• Create style sheets.

Terms
New terms used in this lesson include:

• Font - A library object used to define fonts in Dialogue.

• Style - A characteristic formatting that affects the appearance of documents.

• Style sheet - A collection of styles used to standardize the appearance of text across 
communications.

Additional Information
For more information on this topic, refer to the Dialogue: 

• Design Environment Guide.

• System Administration Guide.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A font is a library used to define 
fonts in Dialogue.
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Administering Fonts
Businesses normally have rules regarding font usage. Dialogue enables the use of flexible font
management by allowing you to install new fonts, as well as deactivating and limiting the use of
any font.

Adding a Font
You may add any font installed on your system into Dialogue. The fonts are added from the
Environment -> Design -> Fonts heading. 

Adding a font

Once you have selected the font, enter the font properties. With the font properties, you set
usage specifications or deactivate the font.
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Font properties

:: Note

Adding a font in Dialogue allows its use; it does not install the font on all machines. If another
user does not have the font installed, Dialogue uses a substitution font to display.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Limit Font Usage
You may also limit a font to be used only within specifications. By modifying the font properties,
you specify a range of point sizes and styles. You also set specific Allowed Sizes.

Limited font settings

Deactivating a Font
Deactivating a font makes the font unavailable, yet the font remains in the Dialogue system. You
deactivate a font by setting the User Restrictions to Unavailable in the Property Panel.

Allowing User Fonts
In the system configuration (Environment -> System -> System Settings -> System Configuration)
you may elect to Allow user fonts to enable the use any workstation font, including those not set
up in the Library.

Allow user fonts
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

SETTING UP THE DESIGN ENVIRONMENT
Fonts, Styles, and Style Sheets 4UNIT
 Tip

Setting up the Design default is a 
good idea to make sure basic 
design standards are included on 
pages without style sheets, but you 
cannot enforce heading styles with 
the Design defaults.
Setting System-Wide Design 
Defaults
In addition to installing fonts, you also set system-wide design settings. These are the default
design settings that are enforced when a user creates a page without a page template or any
styles. These settings are overridden by templates and style sheets.

Default Design

Single Design Resolution
You specify the Design Resolution, which sets the dots per inch (dpi) resolution for the output
device. The higher the dpi, the finer the resulting image. 

Indent
You set the default indent when a new line is started. The indent is defined as needed (in inches,
millimeters, picas, etc.). Every time a carriage return is entered in the Designer, this space is
automatically applied to the new line.

Default font, Bullets and Numbering
You define the default font for Dialogue. You also set the bullets for up to four levels of lists. You

select which character to use for each level of listing from the font character map.

  Demonstration Observe the demonstration.
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A style is characteristic formatting
that affects the appearance of
documents.
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Styles
Styles define characteristic formatting that affects the appearance of documents. These
guidelines indicate how a font is used within the document. There are two types of styles:

• Paragraph styles - Indicate the characteristics of the text, as well as paragraph settings: spacing,
indent, bullets, and flow.

• Text styles - Indicate the characteristics of only the text font, size, and usage.

For example, use a paragraph style to format a block of text and a text style to format a handful of
words for emphasis.

Text style compared to paragraph style

:: Note

Once a style has been created, you cannot change the style type. If you decide to change a
paragraph style to a text style, you must delete the style and start over. 

Paragraph Style
• 11 point Avenir

• 0.100 Indent

• Single Spacing

• Column flow
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Create and Define a Style
Create a new style by browsing to Environment -> Design -> Styles, right-clicking the heading,
and selecting New Style. 

Create a style

When a style is created, three things are defined:

• The style name.

• The style type: text or paragraph.

• The style following: indicate the style the system defaults to after the designer presses ENTER.

After giving a name, description and next style, you may change the properties you have defined.
You may not, however, change the style type.

Style properties
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A style sheet is collection of styles 
used to standardize the 
appearance of text across 
communications.
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Style Sheets
Style sheets are a collection of styles used to standardize the appearance of text across
communications. 

By creating a style sheet, you control which fonts are available to designers and how these fonts
are used. For example, a style sheet may contain the font size and type for several levels of
headings. 

Style sheets may be applied to documents and pages in Dialogue. 

Planning a Style Sheet
Styles are not implemented until they are part of a style sheet. Prior to creating the style sheet,
consider how the styles work together. For example, what kind of style follows a heading or an
embedded list?
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Create and Define a Style Sheet
Create a new style by browsing to Environment -> Design -> Style Sheets, right-clicking the
heading, and selecting New Style Sheet. 

Create a style sheet

After giving a name and description, fill out the properties, including adding styles.

Style sheet properties
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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 Tip

When adding many items, such as 
styles to a style sheet, select 
several items in the library view (by 
clicking SHIFT prior to selecting 
each one) and drag the group into 
the dialog box or Property Panel.
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Adding Styles to Style Sheets
Once a style sheet has been created, start adding styles to it. First, select which type of style to
add, a Paragraph Style or a Text Style. The current selection determines what fonts appear within
the selection window. For example, if Paragraph Style is selected, you see only paragraph styles.

Add a style to the style sheet by clicking on the  button. A Select Style dialog box opens. Select
the style to add and click OK.

Select Style

Once the style is added to the style sheet, define the style. Each of the styles are defined in terms
of the following categories.

• Text Properties - Sets the properties of all styles for font style, size, and color. This is the only
category available for text styles.

• Paragraph Properties - Sets properties of paragraph styles for indent and spacing.

• Bullets - Sets properties for bulleted paragraph styles.

Enforcing Style Sheets
When you have created a style sheet, it may be enforced on all successive pages. To do this, set
the Enforce This Style Sheet option on the Style Sheet Properties page. When enforced, all users
must adhere to the standards detailed in the Style Sheet. Users may not deviate from the styles

contained in an enforced style sheet.

:: Note

Since you define a style when you add it to a style sheet, one style may be used in many
different ways. The same Style 1 may be completely different on two different style sheets.

  Demonstration Observe the demonstration.
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Independent Exercises: Fonts, 
Styles and Style Sheets

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Add the Times New Roman font, the restricted Verdana font, and then
create a style sheet, based on the specifications given.

Task Specifics

Add a font • Add the Times New Roman font face.

Add a restricted font • Add the Verdana font face.

• Restrict the font to sizes 11, 12, and 14.

• Disable the strikethrough option.

Set design defaults • Set the system-wide design defaults to 11 point Times
New Roman.

Create paragraph styles • Create a style for Vivanet Body Text, Vivanet Heading
1, Vivanet Heading 2, and the Vivanet Bulleted List. 

Create a style sheet • Create a Vivanet style sheet for all three styles.

 Success!
You have completed the Fonts, Styles, and Style Sheets exercises.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Guided Exercises: Fonts, Styles and 
Style Sheets

Add a Font

In Design Manager:

 Exercise Add Arial to Dialogue.

Step Action Display

1. Browse to Environment -> Design ->  Fonts. Library

2.
Right-click the Fonts heading and select Import New
Font. from the shortcut menu.

The New Font dialog box opens.

3. Select Arial from the drop-down list. New Font dialog box

4. Click OK.

5. Exit the Property Panel.

 Success! You have added the Arial font to Dialogue.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



SETTING UP THE DESIGN ENVIRONMENT
Fonts, Styles, and Style Sheets 4UNIT
Add a Restricted Font

In Design Manager:

 Exercise
Add the Verdana font to Dialogue. Limit the font size to 11, 12 and 14
and disable strikethrough.

Step Action Display

1. Browse to Environment -> Design ->  Fonts. Library

2.
Right-click the Fonts heading and select Import New
Font. from the shortcut menu.

The New Font dialog box opens.

3. Select Verdana from the drop-down list. New Font dialog box

4. Click OK.

The font properties appear in the Property Panel.

5. Enter Verdana Font in the Description text box. Property Panel

6.
Select Specified Restrictions in the User Restrictions
drop-down list.

7. Clear the Allow Strikethrough check box.

8. Click the  button under Size Limits.

The Enter font size restriction dialog box opens.

9.
Select the Specific font size option. Enter font size restriction

dialog box

10. Enter 11 in the first field.

11. Click OK.

12. Repeat steps 8-11, and add sizes 12 and 14.

13. Click the  button and exit the Property Panel.

 Success!
You have added the Verdana font to Dialogue with the specified
restrictions.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Set Up Design Defaults 

In Design Manager:

 Exercise
Set the Design Default properties to comply with the Vivanet Style Guide
as much as possible. 

Step Action Display

1.
Browse to Environment -> System -> System
Settings.

Library

2. Drag the System Settings into the Property Panel.

3. Browse to the Text and Fonts tab. Property Panel

4. Click the Font button.

The Select Font screen opens.

5. Select Times New Roman from the drop-down list. Select Font dialog box

6. Select 11 from the Point size drop-down list.

7. Click OK.

8. Click the  button and exit the Property Panel.

 Success! You have set a Design Default of Times New Roman 11 point.
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Create Paragraph Styles

In Design Manager:

 Exercise Create each of the styles described in the Vivanet Style Sheet Summary.

Step Action Display

1. Browse to Environment -> Design -> Styles. Library

2.
Right-click the Styles headings and select New Style
from the shortcut menu.

The New Style dialog box opens.

3. Enter Body Text in the Name field. New Style screen

4. Enter Body Text in the Description field.

5. Select the Paragraph Style option.

6. Click Finish.

The text style properties appear in the Property Panel.

7. Select Body Text from the Next style drop-down list. Property Panel

8. Click the  button and exit the Property Panel.

9.
Define the Heading 1 and Heading 2 styles. Use the
document from John for the names

 Success! You have created three new styles.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Create a Style Sheet

In Design Manager:

 Exercise Build the Vivanet style sheet based on the styles you have created.

Step Action Display

1. Browse to Environment -> Design -> Style Sheets Library

2.
Right-click the Style Sheets heading and select New
Style Sheet from the shortcut menu.

The New Style Sheet dialog box opens.

3.
Enter Vivanet Style Sheet in the Name field. New Style Sheet dialog

box

4. Enter Default Style Sheet in the Description field.

5. Click Finish.

The Style Sheet properties appear in the Property Panel.

6. Click the   button. Property Panel

The Select Style dialog box opens.

7. Select Body Text. Select Style dialog box

8. Click OK.

9. Select Times New Roman from the drop-down list. Property Panel

10. Select 11 from the Point size drop-down list.

11. Click the  button.

12.
Repeat step 6-13 and add the Heading 1 and
Heading 2 styles. Use the document from John for
the style definitions.

13. Exit the Property Panel.

 Success! You have created a style sheet as specified.
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Create and Define a Paper Type

– Paper Type Properties

Create and Define Design Layers

– Setting Up a Design Layer

Independent Exercises

Guided Exercises
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RGB Color

– Create the Vivanet Colors: Insert a 
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– Create the Vivanet Colors: Insert a 
Relative Color
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– Create and Define a Letterhead 
Design Layer

– Assigning Objects to a Letterhead 
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Colors, Paper Types, and Design Layers
Your company may have a custom color set or use color for emphasis. You create and modify your
own color schemes in Dialogue. 

To create quality documents, specify the media. By specifying paper type attributes, you create
publications that are produced specifically for your output materials. 

Design Layers are another useful tool that enables you to create many levels of design elements,
which you add or strip away as needed. Layers are used to create complex multi-layered design
elements, or used to place guidelines in the Designer, which are not printed at production time.
This lesson describes how to define color, paper types and design layers.

Objectives
By the completion of this lesson, you will be able to:

• Create and define a color family.

• Create and define named colors, including an RGB color, a CMYK color, and a relative color

• Create and define a paper type.

• Create and define a design layer.

Terms
New terms used in this lesson include:

• Color Family - A Dialogue feature that enables you to create a set of named colors that are
specific to your organization. 

• Design layer - A virtual layer that selectively adds and removes content based on a destination
device.

• Named color - A user-defined custom color that you create in color families.

• Paper type - An object used to define the size, weight, and color of paper stock, as well as
media names for printer control.

Additional Information
For more information on this topic, refer to the Dialogue:

• Design Objects Guide.

• Publication Support Guide.

• System Administration Guide.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Color families enable you to create 
a set of named colors that are 
specific to your organization. 

A named color is a user-defined 
custom color that you create in 
color families.
156
Student Guide ::

Dialogue System Administration
Design Colors
You can add your own custom color scheme to the Dialogue Designer using color families. These
colors are used to send the specific color instructions to the printer.

A color family is a container. You must define color types to compose a color family. A color family
may contain any number of custom colors. Colors are formed by two schemes: RGB and CMYK.
These schemes ensure the best color fidelity by matching the displayed colors with the actual ink
mixtures used by printers.

• The RGB Color Scheme is formed by light absorption, using the colors red, blue, and green and
adding or subtracting light. 

• The CMYK Color Scheme is formed by light refraction, using the colors cyan, magenta, yellow,
and black.

Use either of these schemes to define named colors. For example, if you wanted to create forest
green, and you wanted to use the RGB Scheme, set the values of [Red: 0, Green: 128, Blue: 0].
However, if you were using the CMYK scheme, use the values of [Cyan: 50, Magenta: 0, Yellow: 50,
Black: 50] to attain the same color.

As you define your color, the following options are changed, based on your current color:

• Black and White - There are only two options for this color: black or white. Dialogue determines
which color, based on the current shade.

• Grayscale - If your color opens in a gray scale print, there are 255 shades of gray available to
substitute for the color. Dialogue determines the shade based on the current shade and hue.

• Raster BW - (Not available for Custom Colors) Rasterization shows the interpretation of the color
in a rasterized, non-color display.
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Create and Define a Color Family
Create a new color family by browsing to Environment -> Design -> Color Families, right-clicking
the heading, and selecting New Color Family. 

Create a color family

After giving a name and description, the properties open in the Property Panel. The only property
for a color family is the name and description.

Color description
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Create and Define a Named Color
Create a new color by browsing to Environment -> Design -> Color Families, right-clicking an
existing color family, and selecting Insert New Color. 

Create a named color

After giving a name and description, the properties appear in the Property Panel. Set the shade by
clicking the color well.

Color properties

The Color dialog box opens. Select the Color model to choose the palette and then enter the
color values to define your color.

Color Well
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Color

Output Color Name
Enter an output color name if your printer requires a name string instead of the RGB or CYMK
values. Enter the name exactly as read by the printer. Otherwise, the color is defined using the
CMYK values entered in Dialogue to define the named color.

Relative Colors
You may want to define many colors based on one color. For example, you may wish to create a
color set of orange shades: starting with an plain orange color, you want to create gold, tangerine,
and amber. 

After you have designed your basic orange, create a a new color called Gold. Then click the
Shaded Color Relative To Another Color check box. This activates the shade slider, after which you
can slide to lighten or darken the tone to the one you want. You then define both tangerine and
amber based on the basic orange color. If you change a color that has relative links, all of those
relative colors are affected.

  Demonstration Observe the demonstration.
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A paper type is an object used to 
define the size, weight, and color 
of paper stock, as well as media 
names.
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Create and Define a Paper Type
Most publications created in Dialogue require printing. To ensure the best accommodation of the
print medium, entering the paper type characteristics promotes efficient printing and generates a
presentable product. However, paper types do not always define physical paper. Paper types may
also define the screen properties for electronic output.

Create a new paper type by browsing to Environment -> Design -> Paper Types, right-clicking the
heading, and selecting New Paper Type. 

Create a paper type

After giving a name and description, configure the paper type properties.

Paper type properties
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Paper Type Properties
When you create a new paper type, you must define its properties. Consider the following basic
attributes:

• Paper Height 

• Paper Width 

• Paper Weight

• Paper Color

If you are defining the paper width for electronic output, like an image, you only need to set the
width. The paper width is converted to pixels when generating the output to the screen. Since
electronic pages scroll, the paper height is not important: it is set automatically. Use the following
formula while planning the dimensions:

# of pixels / 96 dpi = # inches

Therefore, 770 pixels per inch is about 8 inches, which is ideal for a 800x600 screen.

Media Names
You also set Media Names, which are specific printer commands associated with the page. Refer
to the Publication Support Guide for more information about media names.

Attribute Description

Postscript Media Name The name that is used with the PostScript set page device 
command.

Metacode Stock Name The name that is used with the Dynamic Job Description Entry 
command.

AFP Copygroup Name The name that is used with the Invoke Media Map command.

PCL Tray Command Specifies any Printer Control Language commands to execute.

Add Orientation Suffix Adds a suffix to the name indicating the page orientation.

HTML Background 
Image

Sets up the HTML background image, detailed below.

AFP Formdef Options Enables you to specify a presentation device media source.
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HTML Background Image
If the page contains an HTML printout, you specify a background image as a watermark. This
setting is used only for HTML output. After you specify the image (.jpg, .gif and .png formats are
supported), specify the image layout properties:

• Tile - The image appears normal size and repeat in a grid until the background is entirely filled.

• Center - The image opens in the center of the background, normal size.

• Stretch - The image is stretched to entirely fill the background.

Example of HTML Background Image

AFP Formdef Options
Many images may be set up within a page. This is set in the AFP Formdef Options.

• Generate as an N-Up Page In Copygroup - Select this box to set the page as an N-Up page.

• N - Specify how many images are generated per page.

  Demonstration Observe the demonstration.
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Create and Define Design Layers
In Dialogue, design layers enable multiple layers of elements that may or may not be present
during production. Design layers:

• Help determine the spacing of objects to be printed.

• Include printer marks.

To create a new design layer, browse to Environment -> Design -> Design Layer, right-click the
heading, and select New Design Layer. 

Create a design layer

After giving a name and description, fill out the properties.

Design layer properties
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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content based on an output 
device.
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 Tip

If you select Include for outputs or 
Exclude for outputs, you must 
choose which output the option 
references.
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Create a Design Layer
You select one of the following properties when defining a design layer in the Property Panel:

• Always - This layer is used both when designing and when composing to output. 

• Design only - This layer is used only when designing the page, section, paragraph, message, or
template.

• Include for outputs - When you select this option, the Outputs box displays. This layer is used
only for designing and composing to the selected output. This means the layer is displayed if
the object is sent to the specified output(s). 

• Exclude for outputs - When you select this option, the Outputs box displays. This layer is not
used for the selected output. This means the layer is not displayed if the object is sent to the
specified output(s). For example, you use this option if you have a pre-printed letterhead loaded
in a certain printer.

Defining Inclusion Rules
You can also use Rules to define additional conditions for including the design layers. The design
layer appears only if the Use condition is met and all Rules are satisfied.

Designer with an inclusion rule
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Assigning Objects to a Design Layer
You only add objects to a Design Layer in Designer. When in Designer, select the item you wish to
assign to a design layer. Then click the Layer button.

Layer button

 

This opens the Change Design Layer dialog box. Select the layer for the selected element. Once
you click OK, the elements are assigned to that design layer. If the design layer is turned off, those
elements disappear from the Designer View.

Assigning an object to a layer

Toggling Design Layer Views
You may turn off a design layer, which hides the layer and all assigned elements from the Designer
view. However, these elements remain in the object definition. You set up as many layers as
desired.

To toggle the view, go to View->Design Layers in the Designer menu. Select the design layers to

show. Any layer not selected does not display in the Designer view.

  Demonstration Observe the demonstration.

Layer Button
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Independent Exercises: Colors, 
Paper Types, and Design Layers

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Create the Vivanet colors, add the Pinnacle Paper Type, and a create a
design layer for the letterhead.

Task Specifics

Create and define a color family • Create the Vivanet Color Family

Create the Vivanet colors
– Insert a CMYK Color

– Insert a Relative Color

• Insert a CMYK color for Vivanet Blue. 

• Insert a relative color for Vivanet Light Blue.

Create and define a paper type • Create the Pinnacle Page paper type. 

Create and define a letterhead
design layer

• Name the design layer Vivanet Header.

• Set the layer to Design only.

 Success!
You have completed the Colors, Paper Types, and Design Layers 
exercises.
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Guided Exercises: Colors, Paper 
Types, and Design Layers

Create a Color Family

In Design Manager:

 Exercise Create the Vivanet color family to ensure consistent logo colors.

Step Action Display

1. Browse to Environment -> Design -> Color Families Library

2.
Right-click the Color Families heading and select
New Color Family from the shortcut menu.

The New Color Family dialog box opens.

3.
Enter Vivanet Color Family in the Name field. New Color Family dialog

box

4. Enter Vivanet Color Family in the Description field.

5. Click Finish and exit the Property Panel.

 Success! You have created the Vivanet Color Family.
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Create the Vivanet Colors

In Design Manager:

 Exercise Create Vivanet blue using the CMYK palette.

Step Action Display

1. Browse to Environment -> Design -> Color Families Library

2.
Right-click the Vivanet Color Family and select Insert
New Color from the shortcut menu.

The New Color dialog box opens.

3. Enter Vivanet Blue in the Name field. New Color dialog box

4. Enter Vivanet Blue in the Description field.

5. Click Finish.

The color properties open in the Property Panel.

6.
Click the color well in the upper right-hand corner of
the menu.

Property Panel

The Color Table dialog box opens.

7. Select CMYK from the Color Model drop-down list. Color Table dialog box

8. Enter 63 in the Cyan field.

9. Enter 63 in the Magenta field.

10. Enter 0 in the Yellow field.

11. Enter 37 in the Black field.

12. Click OK.

13. Click the  button and exit the Property Panel.
Property Panel

 Success!  You have created the Vivanet Blue color with the CMYK palette.
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Create the Vivanet Colors: Insert a Relative Color

In Design Manager:

 Exercise
Create a color relative to Vivanet Blue: the relative color will be called 
Vivanet Light Blue.

Step Action Display

1. Browse to Environment -> Design -> Color Families Library

2.
Right-click the Vivanet Color Family and select Insert
New Color from the shortcut menu.

The New Color dialog box opens.

3. Enter Vivanet Light Blue in the Name field. New Color dialog box

4. Enter Vivanet Light Blue in the Description field.

5. Click Finish.

The color properties open in the Property Panel.

6.
Select the Shaded relative to another named color
check box.

Property Panel

7. Click the color box under Relative Color.

The Color dialog box opens.

8.
Select Vivanet Color Family from the Color model
drop-down list.

Color dialog box

9.
Select Vivanet Blue from the Color name drop-down
list.

10. Click OK.

11. Enter 20 in the Shade % field.

12. Click the  button.

 Success!
You have created the a new Vivanet Light Blue color based on the
Vivanet Blue color.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Create and Define a Paper Type

In Design Manager:

 Exercise Add the Pinnacle Page Type to the Paper Types.

Step Action Display

1.
Browse to Environment -> Design ->Paper 
Types heading under Environment.

Library

2.
Right-click the Paper Types heading and select 
New Paper Type from the shortcut menu.

The New Paper Type dialog box opens.

3. Enter Pinnacle Page in the Name field. New Paper Type dialog box

4. Enter Pinnacle Page as the Description.

5. Click Finish.

The Pinnacle Page (Paper Type) properties appear in the Property Panel.

6.
Set the Width as indicated by your design
scenario.

Property Panel

7.
Set the Height as indicated by your design
scenario.

8.
Set the Weight as indicated by your design
scenario.

9.
Click the  button and exit the Property

Panel.

 Success! You have added the Pinnacle Page Type to the Paper Types.
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Create and Define a Letterhead Design Layer

In Design Manager:

 Exercise
Create a non-printable design layer to accommodate the Vivanet 
Header for the Vivanet Header Page.

Step Action Display

1.
In the Library, expand the Design heading 
under Environment.

Windows

2.
Right-click the Design Layers heading and 
select New Design Layer from the shortcut 
menu.

The New Design Layer dialog box opens.

3.
Enter Vivanet Header Layer in the Name 
text box.

New Design Layer dialog box

4.
Enter Used for design only in the 
Description text box.

5. Click Finish.

The Vivanet Header design layer is opened in the Property Panel for you to define.

6.
Select Design only from the Use drop-down 
list.

Property Panel

7.
Click the  button and exit the Property 

Panel.

 Success! You have created and defined a non-printable design layer.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Tag Sets and Page Templates Tag Sets

Create and Define a Tag Set

– Tag Set Properties

– Using a Tag Set

Page Templates

Create and Define a Page Template

– Page Template Properties

Adding Objects to a Page Template

– Template Objects 

– Starter Objects

– Duplex Templates

Independent Exercise

Guided Exercise

– Create a Page Template

– Define a Page Template: Adding the 
Logo

– Define a Page Template: Address 
Block

– Define a Page Template: Body Block

Tag Sets and Page Templates
The ability to import external data files into your applications is key to the personalization of your
communications. Dialogue provides an easy way to ensure the desired formatting of this data by
using tag sets.

By specifying attributes and assigning page templates, you create publications that are produced
specifically for your output materials. Page templates may also be set up to easily assemble
documents by pre-defining the object layout and characteristics.

This lesson covers how to define tag sets and page templates within Dialogue.

Objectives
By the completion of this lesson, you will be able to:

• Create and define a tag set.

• Identify the benefits of using a page template.

• Create and define a page template.

• Add objects to a page template.

Terms
New terms used in this lesson include:

• Page template - An object that defines a paper type and controls what type of page is used.

• Tag - A code embedded within a data file that directs applications how to process certain
portions of the content.

Additional Information
For more information on this topic, refer to the Dialogue: 

• Design Objects Guide.

• System Administration Guide.

Modules
In this lesson, you will use the Dynamic File Import module. The Dynamic File Import module is not
included with Dialogue 1:1.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A tag is code embedded within a 
file that directs applications how to 
process certain portions of the 
contents.
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Tag Sets
If you have the Dynamic File Import Module, you may use tag sets to format text when the
Engine runs. This is useful when importing text from a Customer driver file.

A tag is a formatting instruction that opens within the document. For example, a text tag may
indicate that the following text opens as bold, tabbed a pre-defined amount, or that the text
opens in a defined style. If you are using an exported file with formatting tags, using a tag set
interprets the tags and formats accordingly. 

Tags are identified with a tag marker, or a pointed bracket set <>. When the Engine processes a
package file, Dialogue interprets the tag and applies the corresponding formatting to the text
indicated. 

Tag sets have a start tag and sometimes an end tag. The start tag indicates to begin formatting.
The end tag indicates to stop formatting. In this regard, tags work very much like HTML tags.
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 Tip

While only one tag set may be 
used per application, you may 
create many different tag sets. 
Create and Define a Tag Set
Create a new tag set by browsing to Environment -> Design -> Tag Sets, right-clicking the
heading, and selecting New Tag Set. 

Create a tag set

When you create a new tag set, it contains the Dialogue default tags. 

Tag set properties

Tag Set Properties
There are five tag set categories within the properties.

Tab Sets

Text The text to bold, italics, tabs, or identify variables.

Fonts The text in the indicated font format.

Paragraph The paragraph’s properties, such as centering, indenting and spacing.

Tabs Tab spacing.

Style The following selection in a defined style.
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Using a Tag Set
Once you have created and defined the tag set, it must be specified in the application. You may
specify one tag set per application, under the Documents tab.

Using a tag set

  Demonstration Observe the demonstration.

Specify the Tag Set
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Page Templates
Page templates are used to define the paper type and controls what kind of page is used. By
defining characteristics and setting objects within the template, you create consistent pages and
enforce style sheets.

The page template also simplifies document creation by pre-setting components within a new
document. For example, you want to create a template for correspondence. When the user
creates a new page with the template, the letterhead, the date, the watermark, and the body text
box are already set up for the page. The designer has to write the content.

Page templates in the Design Manager

A page template sets the new page with pre-set specifications for:

• Style sheet

• Paper type

• Page orientation setting

• Design defaults

• User restrictions

:: Note

The Dialogue users may create many pages based on templates. Typically, only the system
administrator creates the page templates.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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defines a paper type and controls 
what type of page is used.
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Create and Define a Page Template
Create a new page template by browsing to Environment -> Design -> Templates -> Page
Templates, right-clicking the heading, and selecting New Page Template. 

Create a page template

After you give a name and description, you must enter a paper type to use for the template.

Select paper type
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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After selecting a paper type, fill out the template properties.

Page template properties
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Template Properties
Once a template is created, you define the template properties within three options: 

• Basic

• Design Defaults

• User Restrictions

Basic
The Basic template properties set the fundamental template characteristics, which include the

attributes below.

Design Defaults
The Design Default options for the template enable you to specify new design defaults for tab
size, default font, and bullet schema. This supersedes any system design defaults. Selecting Use
system wide design defaults enforces the definitions in the system settings.

User Restrictions
With User Restrictions, you restrict the Dialogue Designer functionality for the specified page. For
example, you can specify that editors may modify text but not add anything. You can also limit
user access, variables, and font availability in this category.

Attribute Description

Paper Type The Paper Type this template uses.

Default Style Sheet The Style Sheet enforced for this template.

Orientation The layout for the page: portrait, landscape, portrait reversed, or
landscape reversed.

Duplex Prints on both sides of the sheet. (Not supported by all printers)

How to print simplex 
pages on a duplex 
outputs

Indicates the method of printing single-page documents if the
printer is set to duplex.

RTF header size Specifies, in inches, the header space used for Rich Text Files.

AFP Formdef Options Enables you to specify a presentation device media source.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Adding Objects to a Page Template
Once you have created a template, open it in Designer and add objects. 

Template Objects
Template objects enable you to create non-interactive elements. For example, you may add an
image to appear in the background as a watermark. This watermark may not be deleted or altered.

Starter Objects
Starter objects contain text that assists the users, such as helpful hints or instructions. For example,
Enter text here in a text box is an ideal starter object for a text box. Starter objects appear in red
and do not appear on the final composed output.

Starter object

Duplex Templates
A Duplex Template is a template that uses the front and the back of the page. By selecting the
Duplex check box in the Template Options, the printer uses the front and back of the page. This
setting is for design purposes only: it does not affect printers or other outputs.

 

  Demonstration Observe the demonstration.

Starter Object 
for a Text Box
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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You may use RTF imports in 
conjunction with templates to 
create many documents quickly.
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Independent Exercises: Tag Sets 
and Page Templates

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Create a correspondence template based on the model sent to you.

Task Specifics

Create and define a page 
template

• Create the correspondence template.

• Assign the Vivanet Style Sheet.

• Assign portrait orientation.

Define a page template
– Add the logo

– Address block

– Body block

• Arrange the elements of the correspondence
template. Include the Vivanet logo, the address text
box, and the correspondence body. The logo is
located on your computer at C:\110 Dialogue
Vivanet-logo.tif\System Administration

 Success! You have completed the Tag Sets and Page Templates exercises.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

SETTING UP THE DESIGN ENVIRONMENT
Tag Sets and Page Templates 4UNIT
Guided Exercises: Tag Sets and Page 
Templates

Create and Define a Page Template

In Design Manager:

 Exercise Create a Vivanet Correspondence Template that uses the Pinnacle Paper 
type and uses the Vivanet Style Sheet.

Step Action Display

1.
Browse to Environment -> Design -> Templates -> 
Page Templates heading under Environment.

Library

2.
Right-click the Page Templates heading and select
New Page Template from the shortcut menu.

3. Enter Correspondence Template in the Name field.
New Page Template 
dialog box

4.
Enter Correspondence Template in the Description 
field.

5. Click Next.

6.
Select Pinnacle Page from the Paper type drop-
down list.

7. Click Finish.

The Page Template Property Panel opens.

8.
From the Default Style Sheet list select Vivanet Style
Sheet.

Property Panel

9. Select Portrait from the Orientation list.

10. Click the  button and exit the Property Panel.

 Success!
You have created the Vivanet Correspondence Template that uses the 
Pinnacle Page paper type and the Vivanet Style Sheet.
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Define a Page Template: Add the Logo

 Exercise Now open the Correspondence Template and import the Vivanet logo. 
Use John’s sketch as a guide.

Step Action Display

1.
In Design Manager, drag the Correspondence
template into the Edit Panel.

Library

The Dialogue Designer opens.

2. Click the  button. Dialogue Designer

The system asks if you want a click-on image placeholder.

3. Click No.

The Import an image dialog box opens.

4.
Browse to C:\110 Dialogue System 
Administration.

5. Select Vivanet-logo.tif.

6. Click Open.  

The Import an Image dialog box opens.

7. Click OK.
Import an Image dialog
box

A message opens informing you that the original color data has been saved.

8. Click OK.

9. The letterhead image opens in the document. Dialogue Designer

10. Right-click the image and select Image Properties
from the shortcut menu.

The Image Properties dialog box opens.

11. Browse to the Placement tab. Image Properties dialog
box

12. Set the placement as indicated by the design
prototype.

13. Click OK.

14. With the image still selected, click the  button

on the Layout toolbar.

The Change Design Layer dialog box opens.

15. Highlight the Vivanet Header Layer.

16. Click OK.

17. Click the  button.

 Success!
You have designed this segment of the correspondence template. You 
will complete this in the next exercise.
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Define a Page Template: Address Block

In Designer:

 Exercise Continuing from the last exercise, add the address block component to 
the Correspondence Template. Use John’s sketch as a guide.

Step Action Display

1. Click the  button. Dialogue Designer

2. Place a text box under the logo.

3.
Right-click the text box and select Text Properties 
from the shortcut menu.

Text Properties dialog box opens

4. Browse to the Template Object tab. Text Properties dialog box

5. Select Starter Object.

6. In Starter Text enter Type address here.

7. Browse to the Dynamic Size and Placement tab.

8.
Turn off Autosize width and Autosize height. Dynamic Size and

Placement tab

9. Browse to the Placement tab.

10.               
Set the placement properties as indicated by the 
design prototype.

Placement tab

11. Click OK.

12. Click the  button.

 Success! You have designed the entire correspondence template as requested.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Define a Page Template: Letter Body

In Designer:

 Exercise Continuing from the last exercise, add the letter body component to the 
Correspondence Template. Use John’s sketch as a guide.

Step Action Display

1. Click the  button. Dialogue Designer

2. Place a text box under the address block.

3.
Right-click the text box and select Text Properties 
from the shortcut menu.

The Text Properties dialog box opens

4. Browse to the Template Object tab. Text Properties dialog box

5. Select Starter Object.

6. Enter Type body text here in the Starter Text field.

7. Browse to the Dynamic Size and Placement tab.

8. Clear the Autosize Width option.

9. Clear the Autosize Height option.

10. Browse to the Placement tab.

11.               
Set the Text Properties as indicated by the design
prototype.

12. Click OK. Dialogue Designer

13. Click the  button and close Designer.

 Success! You have completed the entire correspondence template.
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Create and Define a Message Type

Graphic Message Templates

Create and Define a Message 
Template

– Basic Settings

– Design Defaults

– User Restrictions

Independent Exercises

Guided Exercises

– Create and Define a Message Types

– Create a Graphic Message Template

– Define a Message Template: Setting 
the Image

– Define a Message Template: Setting 
the Text

– Create a Message from a Message 
Template
While the designers construct the messages, the system administrator controls certain message
properties and how certain images are used. This is done with message types in Dialogue. 

For example, you want to create a certificate. The designer provides the necessary text in the
certificate as a message template, but does not alter the certificate layout, the CEO signature
scan, or the date. These objects are set within a graphic message template.

This lesson describes how to administer message types and graphic message templates within
Dialogue.

Objectives
By the completion of this lesson, you will be able to:

• Identify the four types of messages.

• Create and define a message type.

• Create and define a graphic message template.

• Create a graphic message using a template.

Terms
New terms used in this lesson include:

• Message type - A category for text messages.

• Message template - An object that defines a message type and controls what kind of message
can be placed in a frame.

Additional Information
For more information on this topic, refer to the Dialogue:

• System Administration Guide.

• Messages and Campaigns Guide.

Modules
In this lesson, you will use the High Volume Delivery module. The High Volume Delivery module is
not included with Dialogue 1:1.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A message type is a category for 
messages.
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Message Types
Message types are the basic identifiers for all messages used in a document. Message types are
created by an administrator to guide designer-created messages to the appropriate message
frames. There are four message types in Dialogue: 

There are two objects used to create messages in Dialogue:

• Message type - A message type is the fundamental category identifier of a message and is used
by message frames to place the appropriate message. For example, an Article 1 message type
identifies any message created with it as Article 1 and includes this message in any frames
requesting an Article 1 message type.

• Message template - A message template creates a ready-made message that the user builds
upon. For instance, a message template may provide an introduction.

When you create a frame, you are asked what message type to include. Think of message types as
the media elements within a page: articles, banners, and images.

Planning a Message 
Before you begin building a message type, plan what the message contains and how it is to be
used by designers.

• Is the message text-based or graphic-based?

• What style sheets are attached to the message?

• Who will use this message type?

• What messages can be created?

• What message frames are needed to create these messages?

Once you have built the message type, create text messages using that type. If you are using
graphic messages, you must create a message template in addition to the message type.

Message Type Description

Text A communication that contains text and embedded graphic 
objects. They are placed on a page in areas held in reserve by 
frames. 

Graphic A communication that is created using design objects. They 
are placed on a page in areas held in reserve by frames. 

Insert A pre-printed message stored in an inserter bin that can be 
added to customer documents during output.

Graphic/Insert Messages that are a pre-printed insert or a graphic message, 
depending on whether the message is defined for the inserter 
bin.
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Create and Define a Message Type
Create a new message type by browsing to Environment -> Design -> Message Types, right-
clicking the heading, and selecting New Message Type.

Create a message type

After giving a name and description, complete the properties.

Message type properties

  Demonstration Observe the demonstration.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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 Tip

A text message contains an image 
only if it is embedded, but a 
graphic message may contain text.
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Message Templates
Message templates are used to create graphic messages, or starter messages that the designer
may add to, but not delete. 

Some uses for message templates:

• The company logo and mission statement.

• An article that features the same introduction and end text, but lacks the body.

• A image border around the message to be created. 

:: Note

Only graphic messages use message templates. Text messages do not use message
templates.
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Create and Define a Message 
Template
Create a new message template by browsing to Environment -> Design -> Templates -> Message
Templates, right-clicking the heading, and selecting New Message Template. 

Create a message template

After giving a name, description, and message type, complete the properties. The properties are
categorized within three tabs: Basic, Design Defaults, and User Restrictions.

Message template properties
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Basic Settings
The basic settings show a thumbnail of the image, as well as the following settings:

Design Defaults
The Design Defaults set overrides to the system-wide Design Defaults, if the Use system-wide
design defaults check box is cleared.

User Restrictions
The user restrictions apply to anyone modifying the template (not messages generated from the

template). 

Setting Indicates

Message Type The message type to use with this template.

Default Style Sheet The style sheet to be used when building this template.

Width and Height The dimensions of the message: they are not changed in
Designer.

Front and Back Color 
Boxes

The color of the message.

Border Settings The border width, color, and type, if any.

Space Settings The space to leave above or below messages.

Setting Allows

Add Objects to be added to this template (text, images, etc).

Delete Objects to be deleted from this template.

Move Objects to be moved in this template.

Rotate Text Text to be rotated in this template.

Inclusion Rules Inclusion rules to be set when this template is used.

Dynamic Positioning or 
Sizing

Dynamic positioning and sizing (growing, shrinking, relative
placing) to be used when this template is used.

Resize Objects to be resized in this template.

  Demonstration Observe the demonstration.
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Independent Exercises: Message 
Types and Message Templates

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Create and define the message types and message template as 
described in the Project Guide.

Task Specifics

Create and define a message 
type

• Create a graphic message type for the seasonal 
promotion.

Create a message template • Create a message template for the seasonal 
promotion.

Define a message template
– Setting the image

– Setting the text

• Use the specialpromo.bmp image in the C:\110 
Dialogue System Administration\ directory.

Create a message from a 
message template

• Create a sample message of the seasonal promotion 
from the message template.

 Success!
You have completed the Message Types and Message Templates 
exercises.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Guided Exercises: Message Types 
and Message Templates

Create and Define a Message Type

From Design Manager:

 Exercise Create a message type for the Vivanet Promotion.

Step Action Display

1. Browse to Environment -> Design -> Message Types Library

2.
Right-click the Message Types heading and select
New Message Type from the shortcut menu.

The New Message Type screen opens in the Property Panel.

3. Enter Vivanet Promotion in the  Name field.

4. Enter Vivanet Promotion in the  Description field.

5. Click Finish

The message type properties appear in the Property Panel.

6.
Assign the Vivanet Style Sheet as the Default style
sheet.

Property Panel

7. Click the  button and exit the Property Panel.

 Success!
You have created and defined a message type for the Vivanet Promo-
tion.
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Create a Message Template

From Design Manager:

 Exercise Create a message template for the Vivanet Special Promotion.

Step Action Display

1.
Browse to Environment -> Design -> 
Templates -> Message Templates

Library

2.
Right-click the Message Templates heading 
and select New Message Template from the 
shortcut menu.

The New Message Template dialog box opens.

3. Enter Vivanet Promotion in the Name field.
New Message Template dialog 
box

4.
Enter Vivanet Special Promotion in the 
Description field.

5. Click Next.

The Select the Message Type dialog box opens.

6.
Select Vivanet Promotion from the Message 
Type drop-down list.

Select the Message Type dialog 
box

7. Click Finish.

8. Click the  button. Property Panel

The Select Style Sheet dialog box opens.

9. Select Vivanet Style Sheet. Select Style Sheet dialog box

10. Click OK.

11. Set Width to 4. Property Panel

12. Set Height to 2.5.

13.
Click the  button and exit the Property 

Panel.

 Success! You have created a new message template for the Vivanet Promotion.
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Define a Message Template: Setting the Image

From Design Manager:

 Exercise Define the message template to contain the Vivanet Promotion image.

Step Action Display

1.
Browse to Environment -> Design -> 
Templates -> Message Templates

Library

2.
Drag the Vivanet Promotion message template 
into the Edit Panel.

The Dialogue Designer opens.

3. Click the  button. Dialogue Designer

The system asks if you want a click-on image placeholder.

4. Click No.

The Import an image dialog box opens.

5.
Browse to C:\110 Dialogue System 
Administration\. 

6. Select specialpromo.bmp

7. Click Open.

The Import an Image dialog box opens.

8. Click OK. Import an Image dialog box

A message opens informing you that the original color data has been saved.

9. Click OK.

10.
The special promotion image opens in the
document.

Dialogue Designer

11.
Right-click the image and select Image 
Properties from the shortcut menu.

The Image Properties dialog box opens.

12. Browse to the Placement tab. Image Properties dialog box

13.
Set the horizontal position to 1.5 and the 
vertical position to .25.

14. Click OK.

15. Click the  button. Dialogue Designer

 Success! You have added a image to the message template.
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Define a Message Template: Setting the Text

From Designer:

 Exercise
Continuing from the previous exercise, add the text, "A new offer for our 
valued Vivanet customers:" and add a text box with the starter text, "Put 
promotion details here."

Step Action Display

1. Click the  button on the Drawing Toolbar. Dialogue Designer

2.
Create a text box underneath the special 
promotion logo.

3.
Right-click on the text box and select Text  
Properties.

The Text Properties dialog box opens.

4. Click on the Placement tab.

5.
Set the horizontal placement to 0.25, vertical to 
0.8, width to 3.0, and height to 0.25.

Placement tab

6. Click OK.

7.
Enter the text: A new offer for our valued 
Vivanet customers:

Dialogue Designer

8. Click the  button on the Drawing Toolbar.

9.
Create a text box underneath the one just 
created.

10.
Right-click the text box and select Text  
Properties from the shortcut menu.

The Text Properties dialog box opens.

11. Browse to the Template Object tab. Text box properties dialog box

12. Select the Starter object check box. Template Object tab

13.
Enter Provide promotion details here in the 
Starter text field.

14. Browse to the Placement tab.

15.
Set the horizontal placement to 0.25, vertical to 
1.25, width to 3.5, and height to 1.0.

Placement tab

16. Click OK.

17. Click the  button and close Designer.

 Success! You have completed the promotional message template.
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 Tip

When the designers use this 
graphic message, the logo and 
lead-in are already in place. All 
they need to do is add a line about 
the promotion.
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Create a Message from a Template

From Design Manager:

 Exercise Create a promotion message using the template you just created.

Step Action Display

1. Browse to Exstream -> Messages Library

2.
Right-click the Messages heading and select 
New Message from the shortcut menu.

The New Message dialog box opens

3.
Enter Vivanet Promotion Message Test in the 
Name field.

New Message dialog box

4.
Enter Vivanet Promotion Message Test in the 
Description field.

5. Click Next.

6.
Select Graphic in the Type of message drop-
down list.

7. Click the  button.

The Select Message Type dialog box opens.

8. Select Vivanet Promotion. Select Message Type dialog box

9. Click OK.

10. Click Finish and exit the Property Panel. New Message dialog box

11.
Drag the Vivanet Promotion Message Test into 
the Edit Panel.

Library

The Dialogue Designer opens.

12.
Double-click the box containing Provide 
promotion details here.

Designer

13. Add any text describing a sample promotion.

14. Click the  button and close Designer.

 Success! You have created a graphic message for the Vivanet promotion.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



Unit Summary Concepts and Exercises

– Fonts, Styles, and Style Sheets

– Defining Color, Paper Types, and 
Design Layers

– Tag Sets and Page Templates

– Message Types and Message 
Templates

Unit Summary
The concepts discussed and knowledge obtained during this unit are built upon in the next unit. If
you have any questions, be sure to ask your instructor during this unit summary.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Concepts and Exercises

Fonts, Styles, and Style Sheets

Defining Colors, Paper Types, and Design Layers

Tag Sets and Page Templates

Concept Exercises

Fonts • Add a Font

• Add a Restricted Font

Set System-Wide Default 
Design

• Set the Default Design Area

Styles • Create a Paragraph Style

Style Sheet • Create a Style Sheet

Concept Exercises

Color Families • Create a Color Family

Colors • Create the Vivanet Colors: Insert a CMYK Color

• Create the Vivanet Colors: Insert a Relative Color

Paper Types • Create and Define a Paper Type

Design Layers • Create and Define a Letterhead Design Layer

Concept Exercises

Page Templates • Create a Page Template

• Define a Page Template: Adding the Logo

• Define a Page Template: Address Block

• Define a Page Template: Body Block
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Message Types and Message Templates

Concept Exercises

Messages Types • Create a Message Type

Message Templates • Create a Message Template

• Define a Message Template: Setting the Image

• Define a Message Template: Setting the Text

• Create a Message from a Message Template
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Basic Output Output Drivers

– Enabling Output Drivers

– pDrivers

– eDrivers

– PDF Security

Create and Define an Output

– Print Streams

Independent Exercises

Guided Exercises

– Create and Define a PDF Output

Basic Output
Dialogue’s output capabilities are controlled through the options set and modified under the
Delivery heading in the Environment. As a Dialogue system administrator, this enables you to
configure the basic output options for the system.

This lesson provides a process by which output drivers and outputs are defined.

Objectives
By the completion of this lesson, you will be able to:

• Identify output drivers.

• Create and define a pDriver.

Terms
New terms used in this lesson include:

• eDrivers - A suite of output driver modules specifically designed for electronic delivery.

• Output queues - Objects used to control multiple devices and processes in a production run.

• Outputs - Objects located under the Delivery heading in the Library that represent supported
output drivers.

• pDrivers - A suite of output driver modules specifically designed for delivery to printers.
Examples include Metacode and PostScript.

• Print stream - The continuous flow of data from one place to another to produce print output.

Additional Information
For more information on this topic, refer to the Dialogue:

•  Output and Delivery Guide.

• AFP documentation.

Modules
In this lesson, you will use the Dialogue pDriver and eDriver suites. These suites are not included
with Dialogue.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Output drivers assemble 
application information for final 
electronic or print output.

 Tip

An application can support more 
than one output driver.
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Output Drivers
An output driver assembles application information for final electronic or print output. The driver

uses this information to incorporate the appropriate commands into the print stream. Your choice
of output driver directly influences the production methods and delivery options available for an
Engine run. As a system administrator, you define the properties of an output driver in different
output objects. These output objects are found in the Library under the Outputs heading. You use
output queues to assign multiple output objects to an application. 

Dialogue supports a wide range of output options in two categories of output drivers.

Enabling Output Drivers
The ability to create output is dependent on:

• The pDriver and eDriver suites and modules.

• The particular set of output drivers enabled in System Configuration.

Each available driver has its check box selected.

System Configuration - pDrivers and eDrivers

Dialogue supports the use of embedded objects in all output drivers. This provides users with the
ability to create pages based on design rather than output method.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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pDrivers are a suite of output 
driver modules specifically 
designed for delivery to printers. 
Examples include Metacode and 
PostScript.
pDrivers

Printer drivers (pDrivers) are printer format drivers that support output in printer-oriented 
standards as listed below.

Name Description

AFP (Advanced Function 
Presentation)

A way of describing the presentation of a document according
to a very structured organization which addresses problems of
reliability, security, transportability, independence of platforms,
data independence, and representation methods.

IJPDS (Ink Jet Printer Data 
Stream)

A proprietary file format for high-speed, full-color, ink jet print
streams. The Dialogue IJPDS driver supports duplex printing
with any number of heads.

Metacode A proprietary standard for Xerox high-speed laser printers, with
kerning and tracking support for fonts, as well as enhanced
shading and area patterns. Highlight and Black and White print
modes are supported for both online (to printer) and offline (to
tape) runs

PCL (Printer Control 
Language)

A page description language used as an emulation standard for
printers and a language now used throughout the industry. In
Dialogue, this Driver provides functionality for PCL versions 4
and 5.

PostScript Developed by Adobe, PostScript is widely used in business
printing, typesetting, and image design. Type42 and Type1
fonts can be created to support Level 2 and Level 3 formats. The
properties for PostScript serve as the basis for three other
output drivers in Dialogue:

PPML (Personalized Print 
Markup Language)

Conceived in 1999, this language enables a printer to hold data
in memory and present it as required for a customer. PPML uses
XML (Extensible Markup Language) as a structural base.

VIPP (Variable Data 
Intelligent PostScript 
PrintWare)

Xerox created this driver as a PostScript device-resident
software.

VPS (Variable Print 
Specification)

A language from Creo Incorporated that supports pre-
rasterizataion of pages at a rate required for digital color
printing. Reusable components are saved in memory and can be
arranged on-demand in a number of different ways.

3211 LD (3211 Line Data) Produces output for line printers. This format is also used by
legacy archive tools.

VDX (Variable Data 
Exchange)

A standard of variable data printing (VDP) that builds on the
strengths and implementation base of PPML.
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eDrivers are non-printer output 
drivers that support output in 
electronic media-oriented 
standards.

For more information on these 
features, see the PDF Properties 
chapter of the Output and 
Delivery guide.
208
Student Guide ::

Dialogue System Administration
eDrivers
Electronic drivers (eDrivers) are non-printer output drivers that support output in electronic media-
oriented standards, as listed below.

PDF Security
Dialogue now features additional security for all PDF output created. You can require a password
to open a document or change its security settings.

In addition, you can restrict the document’s ability to be printed or revised, allow selection of text
and images, and allow addition or revision of annotations and form fields.

These options are configured from the Security tab of PDF output objects in the Property Panel.

Name Description

PDF Composes output in Portable Document Format (.pdf) files that are viewed
and printed with Adobe Acrobat software.

RTF Composes output in Rich Text Format (.rtf) files that are viewed, printed,
and edited in a variety of text editors and word processors.

TIFF Composes output to Tagged Image File Format (.tif) files. Often used for
archival systems. Typically, each page of output becomes one .tif image
file.

HTML Composes output to Hypertext Markup Language (.html) files, a standard
tagged text format.

XML Composes output to Extensible Markup Language (.xml) files, an
emerging tagged text format.

Composed
XML

Produces fully composed XML output containing all the objects sent to the
print stream, including shapes, images, pages, etc. Uses the Dialogue
Exchange Format (.dxf).

PowerPoint Composes output to Microsoft PowerPoint (.ppt) files that are used for
presentations.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Outputs are objects located under 
the Delivery heading in the Library 
that represent supported output 
drivers.
Create and Define an Output
Outputs are objects located under the Delivery heading in the Library that represent supported

output drivers. The procedure for creating an output device is the same whether you use a pDriver
or an eDriver. Only the properties specific to each particular output driver vary.

Create a new output by browsing to Environment -> Delivery -> Output, right-clicking the
heading, and selecting New Output. 

Create an output

After giving a name and description, complete the properties.
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Create an output

The output contains the following property categories.

Tab Properties Include

Basic The driver, color modes, simplex/duplex mode, name and description.

Advanced Character fidelity, search keys, post processors, halftones.

Resource
Management

Fonts, images and overlays.

Paper Bins pDrivers Only. The media used for output. Paper types, trays and bins.

Color The color tables and spot adjustments to use.

Security eDrivers Only. Sets the security features for the output.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Print Streams
You must model the output needed for your applications. The specific properties you define affect
how the Engine produces output. Because the Engine inserts into the print stream all the coded
instructions on how to create pages, documents, and other output from an application, a
significant portion of what determines the content of the print stream are the settings you select
for the particular output driver(s) in use in output objects. Certain types of output drivers utilize

print streams to send output information to an output device, as listed below:

Name Description

AFP • Makes use of long variable blocked records.

IJPDS • Supports 32-bit Vertical Run Length Encoding (RLEV32).

• Compresses output to yield smaller output files. 

Metacode • Accepts data and output commands in ASCII or EBCDIC.

PCL • Enables several different resolutions from a minimum of 300dpi to
600dpi or higher.

PostScript • Includes 14 standard fonts.

  Demonstration Observe the demonstration.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
A print stream is the continuous 
flow of data from one place to 
another, involving print output.
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Independent Exercises: Basic 
Output

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Create a PDF Output.

Task Specifics

Create and define a PDF output • Name the new output object Vivanet PDF.

• Use the PDF driver.

• Use full color coloring.

 Success! You have completed the Basic Output exercises.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Create and Define a PDF Output

In Design Manager:

 Exercise Create a simplex PDF output device that creates color output.

Step Action Display

1. Browse to Environment -> Delivery -> Outputs. Library

2.
Right-click the Outputs heading and select 
New Output from the shortcut menu.

The New Output dialog box opens.

3.
In the Name text box enter Vivanet PDF for 
the new output device.

New Output dialog box

4. In the Description text box enter PDF Driver.

5. Click Finish.

6. Click the Basic tab.

The Vivanet Postscript output device opens in the Property Panel for you to define.

7. From the Driver drop-down list select PDF. Property Panel

8.
From the Color mode drop-down list select Full 
color.

9.
Click the  button and exit the Property 

Panel.

 Success! You have created and defined a PDF output device.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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High-Volume Delivery Barcodes

– Uses for Barcodes

Create and Define a Barcode

Create and Define Inserters

– Types of Messages Specifically for 
Inserters

Create and Define a Banner Page

Output Queues

Create and Define an Output Queue

Independent Exercises

Guided Exercises

– Create and Define a Barcode

– Create and Define a Barcode: 
Barcode Position

– Create and Define a Barcode: 
Barcode Contents

– Create and Define an Inserter

– Create a Banner Page

– Define a Banner Page

– Create and Define an Output Queue

– Add an Inserter and a Banner Page 
to an Output Queue

High-Volume Delivery
Dialogue enables you to control output devices, such as inserters, in an advanced production
facility. In addition, you can create output in a high-volume environment using output objects such
as barcodes, banner pages, and output queues to control production.

This lesson provides the process by which barcodes, inserters, and banner pages are created and
combined to form an output queue.

Objectives
By the completion of this lesson, you will be able to:

• Create and define a barcode.

• Create and define an inserter.

• Create and define banner pages.

• Create an output queue.

Terms
New terms used in this lesson include:

• Banner page - A page added to your output queue as a visual aid to sorting and bundling the
finished output. 

• Barcode - A standard way to represent data so that it can be read by processing and tracking
equipment.

• Inserter - An electronic device for inserting pre-printed messages into an envelope.

• Output queue - An object used to control multiple devices and processes in a production run. 

Additional Information
For more information on this topic, refer to the Dialogue: 

• Output and Delivery Guide.

• 211: High Volume Delivery course.

Modules
In this lesson, you will use the High Volume Delivery module. The High Volume Delivery module is
not included with Dialogue 1:1.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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A barcode is a standard way to 
represent data so it can be read by 
processing equipment.
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Barcodes
A barcode is a standard way to represent data so that it can be read by processing equipment. 

All types can be customized, but they must follow the necessary constraints for the equipment
used to read them.

The various types of barcodes supported by Dialogue have different requirements for properties
such as:

• The size of the bars.

• The thickness of the bars.

• Its position on the page.

Uses for Barcodes
Often, barcodes are defined to control inclusion of preprinted inserts loaded on an inserter. If
there is more than one output queue in an application, the particular queue selected for the
application places the barcode according to the inclusion rules. 

The barcode’s variable data then updates the inserter about current customer information so only
the intended inserts go into a customer’s envelope.

A barcode placed on a message or page is also used to facilitate the Tracking feature in Dialogue.
For example, you can include a campaign number as information to help guide decisions on
future campaigns. These numbers can be tracked as they are inserted or, in the case of a postcard
that can be returned, scanned with equipment.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Create and Define a Barcode
Create a new barcode by browsing to Environment -> Delivery -> Barcodes, right-clicking the
heading, and selecting New Barcode. 

Create a barcode

After giving a name and description, complete the properties.

Barcode properties

You can specify variables within the barcode properties to include information from data files,
control post-processing equipment, and track customer responses. You can include variable
information, such as the customer number or sheet count.
217
Student Guide :: 
Dialogue System Administration



SETTING UP THE DELIVERY ENVIRONMENT
High-Volume Delivery5UNIT
218
Student Guide ::

Dialogue System Administration
You can also set the barcode contents, which specify the variables the barcode communicates,
whether to map these variables, and how many digits to read.

Barcode contents

  Demonstration Observe the demonstration.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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An inserter is an electronic device 
for inserting pre-printed messages 
into an envelope.

 Tip

Since the contents of inserter bins 
can change, configure several 
Inserter objects in the Library for 
the same physical inserter.

 Tip

Use the Graphic or Insert type of 
message in cases where your 
mailing demands more inserts than 
your inserter can hold or if you do 
not have enough preprinted 
inserts.
Creating and Defining Inserters
When you model an inserter object, you define the types of inserters you have available and the
contents of each inserter bin. Add an inserter by browsing to Environment -> Delivery -> Inserters,
right-clicking the heading, and selecting New Inserter. 

Add an inserter

After giving a name and description, complete the properties.

Inserter properties

The inserter properties define:

• A name (and, optionally, a thumbnail) of the pre-printed contents of each bin.

• A barcode used to control insert selection.

• How customer language is factored into the bin selection process.

• The weight of the envelope for the customer pages and inserts.

• A language from the Language Processing drop-down list.

Be sure to update the Inserter object when the contents of a bin change.
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Types of Messages Specifically for Inserters
When the Engine processes an application involving insert messages, Dialogue checks which bin
contains the insert message and whether language controls the selection for each customer. 

• An Insert Message object refers to a preprinted message in an inserter bin. Since these are
already printed, insert messages do not use templates as a basis for their design and cannot be
placed on a page.

• A Graphic or Insert Message selects the insert from the inserter as long as the one is available.

If the insert is unavailable on the inserter, Dialogue computes the message on the page.

  Demonstration Observe the demonstration.
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Creating and Defining Banner Pages
Banner pages are optional pages which print at the start and end of certain production events.
They serve as visual cues to mark breaks in the output. These pages can be static or contain
current or summary information about the production run.

For example, have a banner page mark the end of a batch.

Banner page

Create a new banner page by browsing to Environment -> Delivery -> Banner Page, right-clicking
the heading, and selecting New Banner Page. 

Create a banner page

After giving a name, description and page to use, fill out the properties.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
A banner page is a page added to 
your output queue as a visual aid 
to sorting and bundling the 
finished output. 
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Banner page properties

The banner page properties include the page details, variables, rules, page count and when to
include the banner page.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Output Queues
Output queues control multiple devices and processes in final output production. You use output
queues to:

• Create multiple output files in a production run.

• Control output devices and inserters.

• Send output to different destinations, such as different printers or a mix of print and electronic
equipment.

• Access additional settings to control print stream options.

Both pDrivers and eDrivers benefit from Output Queues. In print production runs, you control
devices such as printers and inserters, and set production features such as jogging and banner
pages.

Although there are no printing devices present with eDriver production, you can use the
properties in an Output Queue to set up such options as output file naming, inclusion/exclusion
rules, and print file separation. 
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
An output queue is an object used 
to control multiple devices and 
processes in a production run.

 Tip

Use output queues to generate a
separate PDF output file for each
customer.
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Create an Output Queue
Create a new output queue by browsing to Environment -> Delivery -> Output Queue, right-
clicking the heading, and selecting New Output Queue.

Create an output queue

 After giving a name and description, fill out the properties.

Output queue properties

You add inserters, banners, and breaks to this output queue by selecting the related tab in the

Property Panel.

  Demonstration Observe the demonstration.
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Independent Exercises: High Volume 
Delivery

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Build an output queue to bolster the hard copy output. Specifically, add
the requested barcode, printer, and banner page, and join them all
together in one output queue.

Task Specifics

Create and define a barcode • Use your scenario to get the barcode specifications, 
and create and define the barcode in Dialogue.

Create and define an inserter • Name it Series 14 Inserter. Use your scenario for 
specifications. Make sure to assign the barcode to the 
inserter.

Create and define a banner 
page

• Create and define a banner page called Queue 
Separator that indicates which queue has just finished 
printing.

Create and define an output 
queue

• Name the output queue Vivanet Printer Output 
Queue.

• Base it on the PDF Printer.

• Use C:\110 Dialogue Training\Output.pdf in 
the Production file for the test file.

• Use EXPDF for the production file.

• Add the Queue Separator banner page.

• Add the Series 14 Inserter.

 Success! You have completed the High-Volume Delivery exercises.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Guided Exercises: High Volume 
Delivery

Create and Define a Barcode

In Design Manager:

 Exercise Create a barcode and set its basic properties.

Step Action Display

1.
Browse to Environment -> Delivery -> 
Barcodes.

Library

2.
Right-click Barcodes and select New Barcode 
from the shortcut menu.

The New Barcode dialog box opens.

3. In the Name text box enter Standard 3of9. New Barcode dialog box 

4.
In the Description text box enter Standard 
3of9 barcode.

5. Click Finish.

6.
The Standard 3 of 9 barcode opens in the 
Property Panel.

Property Panel

7. Click the Basic tab.

8. From the Type drop-down list select 3 of 9. Basic tab

9.
From the Objects that can reference this 
barcode drop-down list select Inserters only.

 Success!
You have created and started the definition of the Standard 3of9 
barcode. Continue with the barcode position.
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In Design Manager:

 Exercise Continuing from the previous exercise, provide the barcode position
details for the new barcode.

Step Action Display

1.
From the Placement reference drop-down list 
select Upper left (portrait).

Property Panel

2. From the Bottom list select 2.350.

3. From the Left list select 8.100. 

4. From the Height list select 0.180.

5.
From the Orientation drop-down list select 
Face right.

6. As the Barcode font select 39251.

7.
From the Placement drop-down list select 
Below.

8.
From the Orientation drop-down list select 
Face right.

9. Click the  button next to the HRI font field.

The Select Font dialog box opens.

10. Select Arial. Select Font dialog box

11. Click OK.

 Success!
You have defined the Standard 3of9 barcode’s position. Continue with 
the barcode contents.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Create and Define a Barcode: Barcode Contents

In Design Manager:

 Exercise Continuing from the previous exercise, add the barcode contents to
complete the barcode definition.

Step Action Display

1. Browse to the Contents tab. Property Panel

2. In the Digits text box type 5.

3.
From the Type drop-down list select Document 
in break.

4. Select the Map check box.

5. Click the  button.

6.

Repeat steps 2-5 with the information
presented below.

• The Page in document barcode has 1 digit.

• The Total Pages in Doc barcode has 1 digit.

• The Checksum: Base barcode has 1 digit.

• The Bin 1 barcode has 1 digit.

• The Bins 1 to 4 barcode has 1 digit. 

7. Exit the Property Panel.

 Success! You have defined the contents of the Standard 3of9 barcode.
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Create and Define an Inserter

In Design Manager:

 Exercise Add the Series 14 Inserter and assign the 3 of 9 barcode to the inserter.

Step Action Display

1. Browse to Environment -> Delivery -> Inserters. Library

2.
Right-click the Inserters heading and select 
New Inserter from the shortcut menu.

The New Inserter dialog box opens.

3.
In the Name text box enter Series 14 
Inserter. New Inserter dialog box

4. Enter a description in the Description text box.

5. Click Finish.

6. In the Model text box type Series 14. Property Panel

7. Click the top  button under the Barcodes 
heading.

The Select Barcode dialog box opens.

8. Select Standard 3 of 9. Select Barcode dialog box

9. Click OK.

10. Click the  button and exit the Property 

Panel.

 Success! You have created and defined an inserter.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Create a Page

In Design Manager:

 Exercise Create a queue separator page.

Step Action Display

1. Brows to Exstream -> Pages.

2. Create a new page called Queue Banner Page, 
using the Pinnacle Page paper type.

Library

3. Drag the new page into the Edit Panel.

Designer opens.

4. Click the  button on the Drawing Toolbar. Designer

5.
Create a large text box on the middle of the 
page.

6.
Enter the text Banner Page for Queue in the 
text box and press the space bar once.

7. Click the  button on the Toolbar.

The Variable Palette dialog box opens.

8. Select SYS_QueueCurrent Variable Palette dialog box

9. Close the Variable Panel.

10. Click the  button and close Designer.

 Success! You have created a seperator page.
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Create and Define a Banner Page

In Design Manager:

 Exercise Define the banner page in the Production Environment.

Step Action Display

1.
Browse to Environment -> Delivery -> Banner 
Pages.

Library

2.
Right click the Banner Page heading and select 
New Banner Page from the shortcut menu.

The New Banner Page dialog box opens.

3. In the Name field enter Queue Separator. New Banner Page dialog box

4.
In the Description field enter Queue Separator 
Banner Page.

5. Click the  button.

The Select Page dialog box opens.

6. Select Queue Banner Page. Select Page dialog box

7. Click OK.

8. Click Finish. New Banner Page dialog box

The Queue Banner Page options appear in the Property panel.

9. Select the End of Each Queue check box. Property Panel

10. Click the  button and close the Property 

Panel.

 Success! You have defined the banner page.
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Create and Define an Output Queue

In Design Manager:

 Exercise Create and define the Vivanet Printer Output Queue.

Step Action Display

1.
Browse to Environment -> Delivery -> Output 
Queues.

Design Manager

2.
Right-click the Output Queues heading and 
select New Output Queue from the shortcut 
menu.

The New Output Queue dialog box opens.

3.
Enter Vivanet Printer Output Queue in the 
Name text box.

New Output Queue dialog box

4.
Enter PostScript with banner page and inserter 
in the Description text box.

5. Click Finish.

6. Click the Basic tab.

7. Click the  button next to Output.

The Select Output dialog box opens.

8. Select Vivanet PDF. Select Output dialog box

9. Click OK.

10.
Enter C:\110 Dialogue System 
Administration\TestOutput.pdf in the 
Test file text box.

Property Panel

11. Enter EXPDF in the Production file text box.

12. Click the  button.

 Success!
You have created and defined an output queue.
Continue with the next exercise.
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Add an Inserter and a Banner Page to an Output Queue

In Design Manager:

 Exercise
Continuing from the previous exercise, add the Series 14 Inserter and the 
Queue Separator banner page to the Vivanet Printer Output Queue.

Step Action Display

1. Browse to the Inserters tab. Property Panel

2. Click the  button.

The Select an item to add to the list dialog box opens.

3. Select the Series 14 Inserter.
Select an item to add to the list 
dialog box

4. Click OK.

5. Browse to the Banners tab. Property Panel

6.
Under the Banner pages to include in output 

heading click the top  button.

The Select Banner Page dialog box opens.

7. Select Queue Separator. Select Banner Page dialog box

8. Click OK.

9.
Click the  button and exit the Property 

Panel.

 Success! You have enhanced the output queue with an inserter and banner page.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Output Sorting Output Sorting

– Run the Engine Twice

– Step 1: Pre-Sort Processing

– Step 2: Post-Sort Processing

Application Consolidator

Output Sorting
With the advanced production-side capabilities of Dialogue, you can process large quantities of
customer documents in a high-volume production environment, support various audit and
distribution processes, and simultaneously produce output for print and electronic delivery
mediums.

This lesson produces an introduction to basic output sorting and bundling concepts. More details
and exercises are available with 211 :: High-Volume Delivery.

Objectives
By the completion of this lesson, you will be able to:

• Describe the benefits of using the Sorting and Bundling module.

• Identify the two steps of the output sorting process.

• Describe the benefits of using the Application Consolidator module.

Terms
New terms used in this lesson include:

• Bundling - Grouping files for output based on specific customer information. One type of
bundling, called householding, groups customer documents together that share the same
address (to reduce mail handling and postage costs).

• Post-sort processing - A second Output Sorting run that produces output according to the
sorted information and data.

• Pre-sort processing - An initial Output Sorting run that produces customer data that you can
sort, cleanse, and update.

• Sort Data File - A file created by the Engine during pre-sort processing that contains customer
information you cannot edit.

• Sort Index File - A file created by the Engine during pre-sort processing that points to customer
data in the Sort data file. This contains one record per customer. You edit the Sort Index File for
a variety of updates such as sorting and updating addresses.

Additional Information
For more information on this topic, refer to the Dialogue: 

• Output Sorting and Bundling Guide.

Modules
In this lesson, you will use the High Volume Delivery module. The High Volume Delivery module is
not included with Dialogue 1:1.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
235

Student Guide :: 
Dialogue System Administration



SETTING UP THE DELIVERY ENVIRONMENT
Output Sorting5UNIT
236
Student Guide ::

Dialogue System Administration
Output Sorting
Dialogue’s optional Output Sorting and Bundling module (part of the High-Volume
Production suite) enables you to conduct extensive sorts of customer output using third-party
software to:

• Make last minute customer updates.

• Conduct address cleansing and mail sorting.

• Sort output based on any information from Driver files (such as alphabetically, by customer
number, by location, and so on).

– Grouping output by any customer-data criterion is called bundling.

– Grouping customer documents by address is called householding. This type of bundling 
reduces postage costs by grouping documents for the same address together.

• Include/exclude certain documents for each customer.

• Send to the print stream certain pages from a document.

• Reprint certain documents from an existing output file.

Run the Engine Twice
There are three major phases to running an application with Output Sorting.

• The first run produces initial customer data and stops processing. This initial Engine run is called
Step 1.

• You manipulate the application’s initial data with third-party software to sort, cleanse, and
update customer information during this interim step.

• After Sorting, you run the Engine a second time to produce output according to the sorted
information. This second run is called Step 2.
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Step 1: Pre-Sort Processing
In Step 1, you run the production Engine to generate a package file, a Sort Data File, and a Sort
Index File.

Sort Data File
A Sort Data File is an output file containing processed customer data in code and must not be
edited. Because it is created outside of Dialogue, it does not appear in the Library.

Sort Index File
A Sort Index File is a columnar file made from the sort data file containing data areas you can edit
to complete user sorting. Because it is created outside of Dialogue, it does not appear in the
Library.

You direct the Engine how to read information in the Sort Data File (during Step 2) by
manipulating the data and arrangement of customer records in the Sort Index File during User
Sorting. Twenty bytes in each Sort Index File record point the Engine to a specific location in the
Sort Data File for specific customer information.

Step 2: Post-Sort Processing
The Step 2 run produces final output. The Engine uses the data stored in the Sort Data file
according to your sorted information in the Sort Index File. During post-sort processing, the
Engine:

• Places barcodes, images, and fonts.

• Generates report files.

• Composes design objects defined to be composed after document sorting.
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Application Consolidator
With the Application Consolidator optional module you can combine multiple package files to
produce a single output file. Enabling consolidated output from various Step 1 package files has
two major benefits:

1. Improved shop loading and production time savings. Ordinarily, there is a one-to-one
relationship between a PUB file and an Output Queue. If your organization produces multiple
package files from step 1 runs, then you have to complete multiple Step 2 runs. By
consolidating multiple PUB files, you improve shop loading and save significant production
time and costs.

2. Improved postage discounts and simplified mail handling. Since you use Output Sorting and
Bundling with the Application Consolidator, you combine all the Sort Index Files for the
various PUB files into one single Sort Index File. During the sorting process, use householding
features to simplify mail handling and improve postage discounts.

You can use Step 1 package files from the same application or from different applications that use
the same Output Queue.
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Exercises

 Exercise This is a class exercise.

Task Specifics

Discuss the merits of the Sorting 
and Bundling Module, and the 
Application Consolidator 
Module.

• Discuss situations where these modules make
production easier.

• Give examples of present sorting methods and needs.

• Discuss sorting methods and strategies that may be
used with the modules.

• Discuss the benefits of using one package file instead
of many.

• Discuss the financial benefits to be gained from these
features.

 Success! You have completed the Output Sorting exercise.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Multiple-Ups Creating Multiple-Ups

– Create and Define a Multiple-Up 
Page

– Create a Multiple-Up Frame

– Orientation

– Imposition

Independent Exercise

Guided Exercise

– Create and Define a Multiple-Up 
Paper Type

– Create and Define a Multiple-Up 
Page

– Create a Multiple-Up Frame Within a 
Page

Multiple-Ups
Dialogue enables you to leverage output by converting print streams from simplex to multiple-up,
as well as associated document changes such as page numbering, total page counts, and inserter
control marks and files to support the multiple-up print format.

This lesson provides a process by which the benefits and use of multiple-ups are identified and the
process of creating multiple-up pages and frames are defined.

Objectives
By the completion of this lesson, you will be able to:

• Create a multiple-up page.

• Create a multiple-up frame.

• Set orientation for a multiple-up page.

• Set imposition for a multiple-up page.

Terms
New terms used in this lesson include:

• Imposition - The process of arranging pages from a multiple-up sheet in the proper order for
printing booklets or brochures.

• Multiple-up - A layout sheet that holds frames for entire pages.

Additional Information
For more information on this topic, refer to the Dialogue:

• High-Volume Delivery Guide.
For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Creating Multiple-Ups
With multiple-up (also known as M-up) printing, you can print several pages on one sheet of
paper.

Multiple-up pages reside under the Multiple-Ups heading in the Library, located under Delivery
Tools in the Environment. To define a multiple-up page, you must have an appropriate paper type
object defined in the Library. 

Create and Define a Multiple-Up Page
You create multiple-up pages in Design Manager or in Designer. If you begin creating the object
in Design Manager, complete designing the object in Designer; if you begin in Designer,
complete defining the object in Design Manager.

To create the multiple-up in Design Manager, browse to Environment -> Delivery -> Multiple Ups,
right-click the heading, and select New Multiple-Up.

New multiple up page

After providing the name and description, you are prompted for the paper type. This determines
the page to print the multiple-ups on, not the size of the multiple-up pages.
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.



For use with Exstream Dialogue version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.

SETTING UP THE DELIVERY ENVIRONMENT
Multiple-Ups 5UNIT
Paper Type

After providing the paper type, the Multiple-Up properties open in the Property Panel. Here, you
change the paper type, the orientation, or specify the language layers. However, the multiple up is
not complete until you add some frames to the sheet.

Multiple up properties
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Create a Multiple-Up Frame
Typically, multiple-up frames appear on the entire sheet, but you can design other objects as well.
For example, you can add custom marks such as registration marks, color bars, and trim marks. In
Designer, multiple-up frames have a yellow background. Each frame represents a different page.

Multiple-up frames
For use with Exstream Dialogue Version 6.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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For more information on rotated 
multiple-up frames, see the 
Multiple-Up chapter of the 
High-Volume Delivery guide.

 Tip

The mixed orientation depicted is 
for illustration. In a multiple-up 
sheet, all of the instances must 
have the same orientation.
Orientation
Pages can be rotated as they are placed into multiple-up frames. When a frame is placed on a
page, its Draw Orientation can be selected.

Orientation example

Option Description

Portrait Rotates all pages so they are placed as Portrait.

Landscape Rotates all pages so they are placed as Landscape.

Portrait Reversed Rotates all pages so they are placed as Portrait Reversed.

Landscape Reversed Rotates all pages so they are placed as Landscape Reversed.

Based on Paper type Places pages in the frames as they are designed.

If the output device cannot rotate resources, the package file includes the appropriate 
rotations. This increases the file size and Engine memory usage.

Landscape

Portrait
Reversed

Landscape
Reversed

Portrait
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Imposition is the process of 
arranging pages from a multiple-up 
sheet in the proper order for 
printing booklets or brochures.
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Imposition
With imposition the Engine takes pages from a multiple-up sheet and arranges them in the correct
order for binding in post-processing. In the small booklet example below:

• The outer duplex sheet needs to have pages 1 and 8 on the back and pages 2 and 7 on the
front.

• The inner duplex sheet needs to have pages 3 and 6 on the back and pages 4 and 5 on the
front. 

With Dialogue, the Engine automatically selects these various pages from a multiple-up sheet in
the correct order.

Imposition - booklet example

There are different ways to use imposition. Select a specific imposition setting in Output Queue

properties, Page Sorting area, on the Sorting and Bundling tab.

  Demonstration Observe the demonstration.
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Running the Engine Preparing a Package File

– Building a Package File

– Batch Files

– Packaging Switches

– Transferring Package Files

Running the Engine

– Command Prompt

– Scripts

– Control Files

– Engine Switches

– Engine Messages

Independent Exercises

Guided Exercises

– Create a Control File

– Run the Engine

– View Engine Messages

Running the Engine
When you have finished building an application with Dialogue, the first step is to create a package
file. Once a package file has been created, you then have to run the Engine. Running the Engine
completes the process by including all variables, imports, components, images, and all other
elements and producing your final product.

Objectives
By the completion of this lesson, you will be able to:

• Prepare a package file.

• Use a batch file for packaging.

• Identify the necessary packaging switches.

• Identify the steps in running the Engine in the production environment.

• Run the Engine from the command prompt.

• Set up a script to run the Engine in a UNIX/LINUX environment.

• Set up a control file to run the Engine.

• View the system report and message file.

Terms
New terms used in this lesson include:

• Batch file - A text file containing commands for running the Engine.

• Control file - A text file created outside of Dialogue that is used to send arguments, in the form
of switches, directly to the Engine.

• Package file - Contains all the objects necessary to run in production mode.

Additional Information
For more information on this topic, refer to the Dialogue: 

• Engine Switches and Return Codes Guide.

• Packaging and Design Engine Guide.

• Production Environment Guide.

• System Administration Guide.

Modules
In this lesson, you will use the Dialogue 1:1 product. No additional modules will be required.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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A package file contains all the 
objects necessary to run in 
production mode.
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Preparing a Package File
After a Dialogue application is created, it must be bundled with all the information, such as rules
and data definitions, that the Engine requires to process the application. The act of packaging
creates a package file. 

Building a Package File
The process of creating a package file occurs in Dialogue’s design environment. You can package:

• An entire application at once.

• Incrementally.

This enables Dialogue to pre-compose the design elements and resources used by the
application, which reduces processing time during a production Engine run.

If you have an application open in the Property Panel when you click the Package Application
button, it is chosen by default in the dialog box. If the application has version labels and has a
version label selected while in the Property Panel, then the label is also chosen by default.

Build Dialogue Package Dialog Box
The Build Dialogue Package dialog box is where packaging options are set. The entire production
process can be completed from this dialog box, including:

• Packaging.

• Running the Design Engine.

• Indicating the output.

Build Dialogue Package dialog box

Click the  button to expand the dialog box and provide additional packaging options. These

options are covered in advanced production classes.
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A batch file is a text file containing 
commands for running the Engine.
Building Production Package File Dialog Box
After you have made your selections in the Build Dialogue Package dialog box and clicked OK,
the Building Production Package File dialog box opens. Click the  button to expand the dialog

box and provide a more detailed view of the packaging process.

Building Production Package File dialog box

After the package file is built:

• Click Cancel to close the dialog box and run the Engine later.

• Click the Engine button to run the Engine.

Batch Files
You use a batch file to package applications. Each line in a batch file signifies a command to be
passed on to the Engine. Because the Dialogue Engine is a batch processor, each command is
executed one line at a time. Batch files are used to automate repetitive packaging and production
tasks. Batch files are created using a text editor and run from the command prompt.

Batch Packaging
In Dialogue, multiple iterations of packaging can be initiated from the command line by making
multiple calls to the Engine within a single batch file. All the applications referenced in the batch
file must use the same data source, which must be the active and current data source in Dialogue.

Packaging from the Command Prompt
To package using a batch file, type the name of the batch file at the command prompt, where the
prompt is pointing to the directory where the batch file is located.

:: Note

In Windows, Dialogue batch files must have the filename extension .bat or .cmd. In UNIX, the
filename extension is .sh.
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Packaging Switches
Packaging switches enable you to send options to the Engine at run time. They are used when
packaging from the command line or from a control file.

If multiple packaging switches are required, they are placed in a control file and called from the
command line or within a batch file. 

Transferring Package Files
Because package files are designed to be platform-independent, they can be transferred from the
Windows design environment to any of the production platforms supported by Dialogue.

Since package files are often very large and require an accurate byte-to-byte transfer between
environments, the following transfer methods are recommended:

• FTP - Used to transfer files from one Internet-connected system to another. A client program
must be running on the system initiating the connection and the host system must be running a
server program which accepts incoming requests. Once connected, files can be transferred in
either direction.

• Across a LAN - For transfers between two machines that are suitably connected, it is possible to
use file sharing or peer-to-peer networking, which makes part or all of the file system of one
machine visible to the other.

• Portable media - For almost any transfer, you have the option of using portable media such as
writable CDs or DVDs, Exabyte tapes, ZIP or JAZ cartridges, or USB flash drive.

:: Note

The -APPLICATION packaging switch is the only mandatory switch necessary for packaging.
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Running the Engine
The Dialogue production Engine can be run on the following operating systems:

You control the production speed of the Engine by allowing a specific number of pages per
minute, as well as limit the Engine for use to a certain user group and the number of Engines that
can be run simultaneously.

Command Prompt
If you are running the Engine on a Windows system, you can run the Engine.exe executable file
from the command prompt by entering the following command:

prodengine -PACKAGEFILE=<control> (where <control> is the name of the package file).

The -PACKAGEFILE switch is the only mandatory command to run the production Engine. This
switch tells the Engine which package file to use in composing the application.

Scripts
You can also run the Engine on a UNIX/LINUX or AS/400 server by using a shell command. For the
script to be executed, upload the script file to the server. A sample shell script is shown below, with
comments to explain the actions occurring with each command:

Sample shell script

This example assumes that all files are in the current directory of execution and that the Engine is
in the execution path of the current user.

• AS/400 • Sun Solaris

• HP-UX • Windows 98/NT/2000/XP

• IBM AIX/RS6000 • z/OS

• MVS/OS-90

:: Note

If the package file name has spaces in it, enclose the file name in double quotes (“ “). The
entire path is only necessary to specify file names when it resides in a different directory than
Dialogue’s home directory.

# The file input.dat is linked to the pseudo-file DD:INPUT1
ln input.data DD:INPUT1

# The file optional.rule.file is linked to the pseudo-file DD:INPUT8
ln optional.rule.file DD:INPUT8

# The Dialogue Engine (called EXSTRE000) is executed with command options
exstre000 -b -t=f -c=control.file -m=message.summary

# A file called DD:OUTPUT1 is created and renamed to output.file
mv DD:OUTPUT1 output.file
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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A control file is a text file created 
outside of Dialogue that is used to 
send arguments, in the form of 
switches, directly to the Engine.
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Control Files
A control file is a text file created in a text editor program that contains the commands necessary
for the production or packaging run. The control file is a means of sending options to the Engine.
When Engine switches are placed into a control file, the only command necessary at the command
prompt or in a batch file is the -CONTROLFILE= command. 

In Windows, Dialogue control files must have the .opt extension. 

Control File Basics
Your control file must have at least the following lines included:

Running the Engine from the Command Prompt
To run the production Engine from the command prompt, type the following at the command
prompt, where the prompt is pointing to the Dialogue installation directory:

prodengine -CONTROLFILE="C:\<control>.dat" (where <control> is the file name of the
control file)

Ensure that any file names containing spaces are surrounded by double quotes.

Engine Switches
Engine switches are used to pass on commands to the Engine at run time. All Engine switches can
be used:

• From the command prompt.

• Within a control file.

Engine Messages
When the Engine runs, it generate a report file if indicated by the control file. This is a good idea,
as the report file details how the packaging occurred, including any errors. The name and location
of the message depends on the attributes set by the -MESSAGEFILE switch.

:: Note

Options that appear in the control file override options selected via the command prompt.

Avoid using spaces between options, values, and successive file names in a command 
line. Example: VERBOSE=ON instead of VERBOSE = ON.

 -PACKAGEFILE=<path ending with filename where the package file is located> 

 -OUTPUTFILE=<path ending with filename you want Dialogue to produce>

 -MESSAGEFILE<path ending with filename for the log file> 
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Message File Languages
Dialogue supports many languages. Many different language versions are available from Exstream
Software. However, regardless of the version, you may specify a language file to output in a

specific language using the –DLGMSGLANGUAGE switch.

Message file language switches

-DLGMSGLANGUAGE Switch Message File Language

–DLGMSGLANGUAGE=FR-FR French

–DLGMSGLANGUAGE=DE-DE German

–DLGMSGLANGUAGE-JA-JP Japanese

  Demonstration Observe the demonstration.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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Independent Exercises: Running 
the Engine

If you need help, refer to the steps provided in the following Guided Exercises.

 Exercise
Run the Engine using a control file, and then read the output and
messages generated by the Engine.

Task Specifics

Run the Engine with a control file • Use the C:\110 Dialogue System 
Administration\controlfile.opt control file.

View Engine output and
messages

• View the C:\110 Dialogue System\ 
Administration\Unit 5 exercise.txt text file.

• View the C:\110 Dialogue System\ 
Administration\Unit 5 exercise.pdf

 Success! You have completed the Running the Engine exercises.
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Run the Engine With a Control File

In Windows:

 Exercise Run the Engine from the command prompt using a control file.

Step Action Display

1. Go to Start->Run Windows

2. Enter command

3. Click OK.

A command.com box opens.

4. Enter C: Command.com box 

5. Press ENTER to move to the local drive.

6. Enter cd c:\progra~1\exstream.

7. Press ENTER to change the active directory.

8.

Type engine -CONTROLFILE=C:\110 
Dialogue System 
Administration\controlfile.opt to 
specify the control file.

9. Press ENTER to execute the Engine.

10.
Type EXIT and press ENTER to close the 
command window.

 Success! You have run the Engine.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2006 Exstream Software.
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View Engine Messages

In Windows:

 Exercise
View the Engine output and messages generated during the production 
run for the ExstreamOutput.pub package file.

Step Action Display

1.
Browse to the C:\110 Dialogue System 
Administration folder.

Windows

2.
Double-click Unit 5 exercise.pdf to open 
the file.

3. Browse through the output and close the file.

4.
Double-click Unit 5 exercise 
messages.txt to open the file.

5.
Browse through the messages and close the 
file.

 Success! You have viewed Engine messages.
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Unit Summary Concepts and Exercises

– Basic Output

– High-Volume Delivery

– Output Sorting

– Multiple-Ups

– Running the Engine

Unit Summary
The concepts discussed and knowledge obtained during this unit are built upon in the next unit. If
you have any questions, be sure to ask your instructor during this unit summary.
For use with Exstream Dialogue version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.
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Concepts and Exercises

Basic Output

High-Volume Delivery

Output Sorting

Running the Engine

Concept Exercises

eDrivers • Create and Define a PDF Output

Concept Exercises

Barcodes • Create and Define a Barcode

• Create and Define a Barcode: Barcode Position

• Create and Define a Barcode: Barcode Contents

Inserter • Create and Define an Inserter

Banner Pages • Create a Banner Page

• Define a Banner Page

Output Queues • Create and Define an Output Queue

• Add an Inserter and a Banner Page to an Output Queue

Concept Exercises

Sorting and Bundling / 
Application Consolidator

• Discuss the merits of the Sorting and Bundling Module,
and the Application Consolidator Module.

Concept Exercises

Run the engine with a control file. • Run the Engine

View the output and message files. • View Engine Messages
For use with Exstream Dialogue Version 5.0 only. All rights reserved. Copyright 1998 - 2007 Exstream Software.


